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RESUMEN 

 

 

TÍTULO: ESTUDIO DE LA RESPUESTA DE UN TRAMO DE TUBERIA DE GAS ENTERRADA 
ANTE EXITACIONES SISMICAS EN LA CIUDAD DE BUCARAMANGA

*
  

 
 
AUTORES: EDGAR ALFONSO ORDÓÑEZ GÓMEZ 

LUIS IVAN TARAZONA TARAZONA
**
 

 
 
PALABRAS CLAVES: 
 
TUBERIAS ENTERRADAS, LINEAS VITALES, INTERACCION SUELO TUBERIA, COEFICIENTE 
DE BALASTO, SISMOS. 
 
 
DESCRIPCIÓN: 
 
 
El informe contiene una breve reseña de la historia del gas en Colombia, el Plan de masificación 
del gas, y demás aspectos que justifican la realización de un estudio de estas características y el 
por qué es importante obtener esta información; además se tratan las consecuencias  que produce 
el colapso de una red de gas enterrada dentro de una ciudad; Contiene este informe además un 
breve manual del programa utilizado para realizar el estudio. 
 
 
Se realizó un análisis dinámico a un tramo de tubería enterrada para el transporte de gas en la 
ciudad de Bucaramanga, y se evaluó la repuesta ante excitaciones sísmicas. Para este propósito 
se seleccionó el modelo de fundaciones de Winkler para la interacción suelo-tubería, algunos 
suelos característicos de la ciudad y sus propiedades y las condiciones en los extremos del tramo 
de red de gas de la ciudad. 
 
 
Se realiza una verificación del modelo seleccionado realizando un estudio comparativo con las 
respuestas de investigaciones similares reportadas en la literatura. Para la evaluación de los 
resultados obtenidos se realizara una comparación con respecto a la tensión admisible y la 
capacidad de deformación de la tubería. Con los resultados obtenidos se espera proporcionar 
información y estudio más profundo y eficaz de una tubería de gas enterrada. 

 

Finalmente, se evalúa la respuesta de un tramo de tubería enterrada en Bucaramanga y se 
reportan las conclusiones. 
  

                                            
*
 Proyecto de Grado 

**
 Facultad de Ingenierías Físico Mecánicas, Escuela de Ingeniera Civil, Director Oscar Javier 

Begambre Carrillo 
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SUMMARY 

 

 

TITLE: STUDY OF THE RESPONSE OF A BURIED GAS LINE TO SUCCESSFUL SEISMICITY IN 
THE CITY OF BUCARAMANGA

*
 

 
 
AUTHORS: EDGAR ALFONSO ORDÓÑEZ GÓMEZ 

LUIS IVAN TARAZONA
**
 

 
 
KEY WORDS: 
 
BURIED PIPELINES, LIFE LINES, SOIL-PIPELINES INTERACTION, EARTHQUAKES. 
 
 
DESCRIPTIONS: 
 
The report contains a brief overview of the history of the gas in Colombia, the Plan of gas mass, 
and other aspects that justify a study of these characteristics and why it is important to obtain this 
information. Also discusses the consequences that produces the collapse of a buried pipeline of 
gas network in a city, this report also contains a brief manual of the program used to conduct the 
study. 
 
 
Dynamic analysis was performed on a section of buried pipeline to transport gas in the city of 
Bucaramanga, and were the response to seismic excitations evaluated, for this purpose it selected 
the Winkler foundation model for soil-pipe interaction, some soils characteristic of the city and its 
properties and the conditions at the ends of the gas network pipeline section of the city. 
 
 
Performs a check on the model selected by a comparative study with the responses of similar 
investigations reported in the literature. For the evaluation of the results are a comparison with 
respect to the allowable stress and deformation capacity of the pipeline. The results obtained are 
expected to provide useful information a more thorough and effective in a buried gas pipeline. 

 

Finally, we evaluate the response of a pipe buried in Bucaramanga and reported the findings.  

                                            
*
 Thesis of Grade  

**
 Mechanical Engineering Faculty of Physics, School of Civil Engineering, Director Oscar Javier 

Carrillo Begambre 
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INTRODUCCION 

 

 

Con el constante crecimiento en la demanda de energía a nivel mundial podemos 

afirmar que el gas se ha convertido en una de las materias más solicitadas por la 

civilización ya que presta un importante servicio para su consumo como podemos 

darnos cuenta; en el mercado su utilidad es variable ya sea en urbanizaciones, 

gasolineras e industrias; manejando diferentes entornos los cuales se han visto 

afectados por fenómenos naturales. 

 

Esta utilidad ha traído consecuencias buenas y malas pero esto es algo 

impredecible, encontramos a nivel literario muchos modelos cualitativos y 

cuantitativos que nos permiten representar estos fenómenos de una manera 

aproximada, más no exacta; debido a las condiciones del medio, esto nos lleva a 

crear una imagen cercana de un evento o desastre y tratar de crear estrategias 

para remediar los daños posibles. 

 

El estudio del medio y del entorno en el que se encuentran localizadas las 

diferentes estructuras construidas, y los procesos propuestos por una ingeniería 

sísmica a nivel mundial, han permitido recaudar valiosa información de eventos 

sísmicos, los cuales permiten distinguir ciertos parámetros a tener en cuenta en el 

momento de hacer análisis y obtener  conclusiones sobre las causas, los factores 

del colapso y la destrucción de dichas obras debido a grandes movimientos 

telúricos. 

 

El hombre ha logrado crear herramientas tecnológicas de monitoreo, análisis y 

modelamiento que le permiten entender las causas y hacer estudios para prever 

las consecuencias de estos fenómenos que han cobrado miles de vidas humanas. 

En este proyecto nos enfocamos en el análisis y el comportamiento de tuberías 

enterradas de gas ante excitaciones sísmicas, para ello se usa el software 
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SEUZ.NL y se realiza una comparación entre los resultados obtenidos en este 

estudio y los reportados por (Korea), finalmente, se evalúa la respuesta de un 

tramo de tubería enterrada en Bucaramanga y se reportan las conclusiones. 
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1. GENERALIDADES 

 

 

1.1 OBJETIVO GENERAL 

 

Evaluar la repuesta de un tramo de tubería enterrada de gas en la ciudad,  ante 

excitaciones sísmicas con el modelo matemático  de elementos lineales con 

formulación cubica inelástica y modelar el suelo usando el método de fundaciones 

de Winkler en el cual el comportamiento de la interacción es representado por 

resortes helicoidales no lineales y discretos en tres dimensiones. 

 

 

1.2 OBJETIVOS ESPECIFICOS 

 

 Presentar las hipótesis que plantea el modelo de elementos lineales con 

formulación  cubica inelástica y sus parámetros de estudio y utilizarlo para el 

modelamiento de tuberías enterradas sometidas a acciones sísmicas.  

 Aplicar el modelo de interacción suelo tubería de la fundación Winkler. 

 Elegir un software libre (o de licencia gratuita) que aplique el modelo de 

elementos  líneales con formulación cubica inelástica y permita usar el modelo 

de la fundación Winkler. 

 Evaluar la respuesta de la tubería y sus conexiones. 

 Comparar los resultados con datos de otras investigaciones reportadas en la 

literatura. 
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2. MARCO TEORICO 

 

 

2.1 DEFINICION DEL PROBLEMA 

 

En el caso de redes de tuberías enterradas vitales se ha podido determinar la 

importancia en el análisis de las condiciones del sitio, las propiedades de los 

materiales, tanto de la tubería como de la conformación del suelo y las 

condiciones de colocación. 

 

Un parámetro importante que se debe tener en cuenta al momento de un desastre 

son los incendios; estas tuberías de gas son propensas a desencadenarlos debido 

a las fugas del material transportado después de su colapso, por tal motivo 

debemos tener en cuenta la vulnerabilidad de este tipo de tubería enterrada, su 

comportamiento, las capacidades de soporte y  resistencia ante las deformaciones 

y esfuerzos a los que las tuberías se ven enfrentadas por movimientos sísmicos, 

pueden representar una restauración localizada y menores traumas de una red de 

tuberías a una reconstrucción total de un sistema de redes de tuberías. 

 

Esta vulnerabilidad puede representarse al citar en la literatura eventos sísmicos 

ocurridos en el pasado como: 

 

En armenia Colombia, el sismo del 25 de enero de 1999, produjo 963 puntos de 

fugas visibles en redes principales y se tuvieron que llevar a cabo más de 7000 

reparaciones de tuberías. Las obras tardaron meses para restablecer el 35% del 

servicio. Fuente: www.google.com/vulnerabilidadsismica/link7. 

 

Terremoto de san Fernando california E.E.U.U., el 9 de febrero de 1971, 

ocurrieron 1400 fallas en varios sistemas de tuberías enterradas, la ciudad quedo 
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temporalmente si servicio de gas, agua y alcantarillado. Fuente: 

www.google.com/vulnerabilidadsismica/link7. 

 

El 13 de Agosto de 1868, un terremoto que fue sentido entre Guayaquil y 

Valparaíso azotó el norte de Chile. Primero fue el terremoto, de dimensión notable 

en esa ciudad, luego una serie de incendios a consecuencia del mismo, por fallas 

en tuberías enterradas y finalmente un tsunami que provocó olas de 18 m de 

altura y que fue el que provocó el mayor daño, todo esto produjo Trescientos 

muertos y cuantiosos daños materiales. Fuente: 

www.google.com/vulnerabilidadsismica/link7. 

 

El terremoto de Chi-Chi de 1999 en Taiwán también causo graves daños a los 

sistemas de suministro de gas natural. Más de 100.000 clientes industriales y 

residenciales en la zona de desastre, quedaron sin gas natural después del 

terremoto, y la pérdida económica estimada de cinco grandes compañías de gas 

natural fue de aproximadamente 25 millones de dólares. Fuente:  Article “Seismic 

behavior of a buried gas pipeline under earthquake excitations.” 

 

Es muy probable que estas cifras de daños en los sistemas de tuberías hubieran 

podido ser menores si se hubiera tomado las medidas oportunas de adecuación y 

prevención. 

 

IMPORTANCIA DE LAS TUBERIAS DE GAS 

 

Durante los años 90 el Gobierno Nacional definió en los documentos CONPES, los 

denominados: el Plan de Gas y el Programa para la Masificación del Consumo de 

Gas, las acciones necesarias para promover una matriz de consumo de energía 

más eficiente y conveniente para el país, mediante la sustitución de recursos 

energéticos de alto costo por gas natural y GLP (gas propano) en los sectores: 
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industrial, comercial, residencial y termoeléctrico. Se trazaron dos metas para el 

logro de este objetivo: 

 Llevar gas natural y propano a más de 3.7 millones de familias en el mediano 

plazo, con el concurso del sector privado. 

 Fortalecer la oferta, por medio de la interconexión de los principales campos de 

producción de gas natural de la Costa Atlántica (Ballena) y el interior del país 

(Cusiana- Cupiagua) con los principales mercados regionales del País, a través 

de la construcción de una infraestructura de transporte y distribución de gas 

natural. 

 

El mejor método de transporte, que es eficaz y seguro según la literatura, se da 

por medio de tuberías enterradas por que pueden acumular mayores volúmenes 

con velocidades de suministros importantes, esto reduce gastos y además provee 

de mayor seguridad para la sociedad a nivel de un evento o desastre. Se le 

denomina a esta construcción gasoducto y consiste en la conducción de tuberías 

enterradas por las cuales el gas circula a altas presiones; desde un lugar de origen 

que puede ser una planta de regasificación hasta su entrega que puede ser 

domiciliaria, industrial, etc.; teniendo en cuenta intervalos determinados en los 

cuales por medio de válvulas se controle el flujo del gas. 

 

Con posterioridad, en el año 1994, se expidió la Ley 142 que definió el marco legal 

para la prestación de los servicios públicos domiciliarios. Ámbito en el cual se 

define el gas combustible (Gas Natural y GLP) como un servicio público y se crea 

la Comisión de Regulación de Energía y Gas (CREG), como la entidad encargada 

de desarrollar el marco regulatorio y normativo para las actividades asociadas al 

transporte, distribución y comercialización del gas natural. No obstante la anterior 

normatividad y competencias expresas en el Código de Petróleos y el Contrato de 

Asociación continúan rigiendo para las actividades de exploración, explotación y 

producción del gas natural. 
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A partir de ese momento, se presentaron cambios importantes en materia 

institucional y regulatoria que han consolidado el desarrollo de la industria del gas 

natural. Institucionalmente, Ecopetrol dejó de asumir la responsabilidad de 

ejecutar el Plan de Masificación de Gas de forma centralizada y así mismo de 

acometer la totalidad de las inversiones en infraestructura básica, particularmente, 

lo concerniente a la construcción de gasoductos troncales, para dedicarse 

exclusivamente a la exploración y explotación de hidrocarburos, actividad objeto 

de su razón de negocio. Bajo este nuevo esquema institucional, se dividieron los 

activos de transporte del patrimonio de Ecopetrol y fueron capitalizados en la 

Empresa Colombiana de Gas (Ecogas) creada mediante la Ley 401 de 1997 para 

el transporte de gas. 

 

En el mismo sentido las empresas distribuidoras de gas natural comenzaron a 

ejercer su actividad bajo el régimen jurídico de la Ley 142 de 1.994, sin necesidad 

de la mediación de un contrato de concesión con la nación, excepción aplicable 

sólo a las áreas de servicio exclusivo para distribución de gas natural por red. 

 

El Ministerio de Minas y Energía en cumplimiento de los lineamientos trazados por 

el Gobierno Nacional a través de su Plan de Desarrollo, ha apoyado la ejecución 

de programas que lleven a ubicar al Gas Natural y al Gas Licuado del Petróleo 

GLP en aquellos sectores de consumo donde la prestación del servicio sea técnica 

y económicamente viable. 

 

2.1.1 Condiciones de entorno de la tubería 

 

Una tubería enterrada puede presentar dos condiciones en relación con el suelo la 

primera es que la tubería se encuentre posicionada en un corte del suelo y la 

segunda que esta se encuentre en un terraplén. En el presente análisis solo se 

analizan condiciones de entorno cuando la tubería se encuentra en corte. 
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Para aquellas tuberías que se encuentran en corte se debe  tener en cuenta: 

 La profundidad de enterramiento  

 Condiciones de zanja 

 Propiedades de la tubería 

 Tipo de suelo 

 

Para aquellas tuberías que se encuentran en terraplén se debe tener en cuenta: 

 Material y cantidad de relleno 

 Condiciones de apoyo 

 Propiedades de la tubería 

 

Todos estos parámetros son estipulados para verificar como actúa el suelo sobre 

la tubería, referente a los esfuerzos que éste produce y cómo reacciona la tubería 

a dichos esfuerzos. 

 

2.1.2 Materiales y colocación de la tubería 

 

Las tuberías enterradas son diseñadas esencialmente para soportar las presiones 

de los fluidos que transportan, para resistir las posibles causas de desgaste, 

deterioro, corrosión y para soportar las cargas y sobrepresiones del suelo sobre 

ellas. 

 

Estas características de soporte y resistencia determinan el diseño de las 

secciones, los materiales y los tipos de colocación de las tuberías. 

 

Las propiedades de los materiales de la tubería y las longitudes entre apoyos o 

empotramientos, serán determinantes en el momento de soportar grandes 

flexiones y curvaturas impuestas por los movimientos del suelo provenientes de 

los sismos. 
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De los materiales de las juntas y sus dimensiones dependen los posibles 

desacoples de las tuberías. 

 

La selección  correcta de los materiales de relleno y las diferentes formas de 

apoyo conforman un factor importante en la resistencia de las tuberías frente a los 

esfuerzos a causa de las deformaciones inducidas por los movimientos sísmicos. 

 

2.1.3 Tratamiento del problema 

 

Con relación a tuberías enterradas surge una serie de factores que determinan las 

deformaciones a las que van a ser sometidas y sus características de resistencia. 

Las deformaciones debidas a la propagación de onda se presentan en áreas de 

gran magnitud y dependen de la ubicación de las fallas del suelo sobre las 

tuberías. Se debe estimar a partir del análisis de las siguientes variables: 

 

 La distancia al epicentro del sismo, y las propiedades de los mantos de roca 

definen las características de la señal. 

 Las propiedades de los materiales como peso específico, velocidad de 

propagación y disipación de energía, determinan la forma de propagación de la 

onda a través del subsuelo del sitio en consideración. 

 Los espesores y las inclinaciones de los diferentes estratos, dan origen a 

rebotes y desviaciones de las ondas incidentes. 

 Las relaciones entre las frecuencias naturales de los perfiles de suelo y las 

frecuencias de la señal sísmica producen efectos de atenuación, amplificación 

y en algunos casos de resonancia. 

 Las características de superficie como presencia de laderas y en general la 

topografía puede afectar las ondas que se propagan, en algunos casos 

aumentando sus valores pico. 

 Las condiciones de colocación determinan la rigidez de la estructura ante las 

deformaciones impuestas. 
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2.2 SISMOS 

 

Los Sismos ya sean terremotos o Maremotos son movimientos vibratorios que 

sufre la corteza terrestre sobre un área determinada, el sismo es un fenómeno 

natural, tal vez el que más impresiona al hombre por las pérdidas humanas y 

materiales. La transmisión de las ondas sísmicas, las ondas sísmicas es lo que  

producen los terremotos. Como es difícil ver o presenciar un terremoto se 

provocan con barrenas, el punto donde se produce el terremoto es el 

HIPOCENTRO, y la vertical encima del hipocentro es el EPICENTRO. Se 

producen “olas en la corteza”. 

 

Las ondas sísmicas son recogidas por un sismógrafo, y se quedan grabadas en un 

papel, película fotográfica, ordenador, etc. 

 

Las ondas sísmicas son P, S y L como lo muestra la figuras 1 y 2. 

 

Figura 1. Ondas de cuerpo 

 

Fuente: Hunt, 2005 
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Figura 2. Ondas Superficiales 

 

Fuente: (Hunt, 2005) 

 

 Ondas Primarias. Son de presión o longitudinales, y pueden pasar a través de 

los sólidos, líquidos y gaseosos; en las  profundidades donde la roca es mas 

elástica  viajan rápidamente por las Cuencas Oceánicas y las masas 

Continentales. 

 Ondas Secundarias. Son por sacudimiento y transversales no se admiten a 

través de los líquidos, son lentas y su velocidad es proporcional a la rigidez del 

material que atraviesan. 

 Ondas Largas o Superficiales. Son las que llegan ha la superficie terrestre; 

se propagan en círculos en forma análoga a los que producen en el agua al 

arrojar la piedra sobre esta. 

 

2.2.1 Como se producen los sismos 

 

La estructura interna de la tierra está constituida como lo muestra la figura 3. 

 

http://www.monografias.com/trabajos11/presi/presi.shtml
http://www.monografias.com/trabajos13/cinemat/cinemat2.shtml#TEORICO
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Figura 3. Estructura Interna de la tierra. 

 

Fuente: http://publicaciones.administracion.es/riesgosismico 

 

La litosfera no es continua en la superficie de la tierra sino que está formada por 

diferentes placas que hacen contacto entre sí, estas placas sufren movimientos 

relativos debido a las fuerzas de tensión y compresión que se producen en 

algunas de sus márgenes, dando como resultado la subducción de una placa 

sobre otra. La tierra está formada por ocho placas tectónicas principales, que 

agrupan parte de los océanos y los continentes; hay 3 zonas Sísmicas principales 

una recorre los bordes del Océano Pacifico, otra en el centro del Atlántico, y la 

tercera, el sur de Asía, desde Indonesia hasta el mar Mediterráneo. En estas 

zonas la roca que yace bajo el suelo no es firme. Lo cual se debe a que la parte 

sólida debajo de la corteza terrestre está formadas por placas rocosas,   y cada 

placa es un fragmento de litosfera que se mueve sobre la astenosfera, y este 

movimiento es el que desencadena los terremotos por los bordes de las fallas 

normalmente, aunque también se pueden producir en su interior, determinando así 

el tipo de movimiento y la intensidad del mismo. 

 

Las fallas Se producen por fuerzas de tensión que actúan sobre las capas de la 

Corteza y las fracturan. La tensión determina el deslizamiento de alguna porción 

de la Corteza sobre otra, o bien, que algunos bloques del terreno permanezcan en 
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el mismo lugar o se elevan ligeramente. Hay tres tipos de Fallas Vertical, 

Horizontal, y Mixta. 

 

 Falla Vertical. Se presenta cuando el deslizamiento del terreno ocurre de 

arriba hacia abajo, o viceversa, este tipo de Falla es la más común en la 

corteza Terrestre. 

 Falla Horizontal. Se origina cuando el deslizamiento es en sentido Horizontal y 

al mismo nivel de la Superficie; por ejemplo la Famosa Falla de San Andrés, en 

California, que produjo el terremoto de San francisco, en 1906. 

 Falla Mixta. Como su nombre lo indica, el deslizamiento se efectúa tanto en 

sentido Horizontal como Vertical 

 

El estado de esfuerzos producido por esta perturbación se transmite por todo el 

medio a través de las ondas sísmicas y su disipación obedece a fenómenos de 

fricción y al debilitamiento de la intensidad de energía, al aumentar el área de 

propagación a medida que el frente de onda se aleja de la fuente que lo origino. 

 

2.2.2 Influencia del suelo sobre la onda 

 

Este efecto es muy complejo en la naturaleza, pues incluye: efectos de resonancia 

de ondas en una, dos y/o tres dimensiones; el efecto del comportamiento no lineal 

del suelo para grandes deformaciones (el cual varía la intensidad de los efectos de 

sitio cuanto menos linealmente se comporta el suelo); los fenómenos de 

licuefacción de las capas arenosas; la ruptura del suelo (deslizamientos y 

agrietamientos) accidentes topográficos etc. y requiere estudios de gran detalle 

para su determinación, incluso para zonas de pequeña extensión. 

 

Desde que se produce la perturbación inicial en la roca, y a medida que esta se va 

propagando por los distintos estratos la onda sufre los fenómenos de reflexión y 
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refracción cada vez que su frente atraviesa medios de diferente rigidez, peso 

unitario, forma, etc. 

 

Otros fenómenos tienen relación con las propiedades mecánicas del medio 

transmisor son la amplificación y el amortiguamiento. 

 

 

2.3 COMPORTAMIENTO DINAMICO DEL SUELO 

 

La naturaleza y la distribución del daño sísmico están muy influenciadas por la 

respuesta del suelo frente a cargas cíclicas. Dicha respuesta está controlada en 

gran medida por las propiedades del suelo. Por ejemplo, la susceptibilidad de un 

depósito de suelo para amplificar el movimiento depende de las propiedades 

dinámicas, siendo el módulo de corte y el amortiguamiento principales parámetros 

para modelar la respuesta sísmica del suelo. Estos parámetros se relacionan con 

otras propiedades del suelo, de carácter más físico, como por ejemplo el índice de 

poros, la densidad relativa y la velocidad de las ondas de corte. 

 

Las relaciones entre las propiedades dinámicas (módulo de corte, razón de 

amortiguamiento y la deformación unitaria), se pueden obtener en el laboratorio, 

pero no siempre se cumplen en el terreno, debido a la dependencia de factores 

que no se conocen o no se pueden reproducir fielmente en el laboratorio, como la 

estructura, la edad y la trayectoria de tensiones del suelo.  

 

2.3.1  Factores que influyen en las propiedades dinámicas del suelo  

 

Los factores claves que influyen en las propiedades dinámicas del suelo son: la 

tensión efectiva de confinamiento, el nivel de tensiones en el suelo, el índice de 

poros y la plasticidad del suelo.  
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 Tensión efectiva de confinamiento: Cuando se coloca la tubería esta queda 

confinada o empotrada en el suelo produciendo cierto tipo de tensiones que 

causan un acople entre el suelo y la tubería, al proporcionarse  este equilibrio 

sin presentar ninguna anomalía al conjunto, se dice que hay una relación 

efectiva.  

 

 Nivel de tensiones en el suelo: La tensión del suelo es la fuerza con la cual el 

agua es retenida en los poros del suelo entre las partículas del mismo, cuando 

esta se libera la tensión aumenta puesto que los poro se cierran; luego el suelo 

produce tensión a la tubería provocado por este fenómeno, cambiando así las 

propiedades del sistema, la mejor forma de manejo de este tipo de situaciones 

es controlando la humedad del lugar.  

 

 Índice de poros (e): El índice de poros se define como volumen de huecos 

relativo al volumen de sólido (e = Vh / Vs). Valores de (e): máx y min para los 

principales tipos de suelos: 

 

Tabla 1. Valores Medios del Índice de Poros 

Tipo de suelo e máx. e min. 

Arena 0.9 0.2 

Limo 1.1 0.4 

Arcilla blanda 2.3 0.6 

Turba 2.5 2 

Fuente: Mecánica de suelos, (Braja Dass) 

 

 Plasticidad del suelo: En mecánica de suelos, sólo se utiliza para los suelos 

finos que, dependiendo del contenido de agua y su mineralogía, fluyen sin 

romperse. La plasticidad de un suelo se atribuye a la deformación de la capa 

de agua adsorbida alrededor de los minerales; desplazándose como sustancia 
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viscosa a lo largo de la superficie mineral, controlada por  atracción iónica entre 

sus partículas. 

 

Un suelo está en estado líquido (arcilla o limo muy húmedos) cuando se comporta 

como un fluido Viscoso, deformándose por su propio peso y con resistencia a la 

cizalladura casi nula. Al perder agua, ese suelo pierde su fluidez, pero continúa 

deformándose plásticamente; dado que pierde su forma, sin agrietarse. Si se 

continúa con el proceso de secado (de la arcilla o limo), el suelo alcanza el estado 

semisólido, si al intentar el remolde se desmorona.  

 

Si se saca más agua, a un punto en el cual su volumen ya no se reduce por la 

pérdida de agua, y el color toma un tono más claro, el estado del suelo se define 

como sólido. El estado plástico se da en un rango estrecho de humedades, 

comprendidas entre los límites  líquido y plástico. Este rango genera el Índice de 

Plasticidad IP, definido así:  

 

                                                      𝑰𝑷 = 𝑾𝑳 −𝑾𝑷                                           (1) 

 

2.3.2 Clases de suelos presentes en la ciudad 

 

En la ciudad de Bucaramanga se presentan diversidad de suelos que veremos a 

continuación. 

 

En el estudio de microzonificación sísmica, (ingeominas, junio 2001, director 

Adolfo Alarcón Guzmán),  se trataron varias zonas para la ciudad, las cuales se 

van a tener en cuenta en el análisis del modelo; y éstas están representadas por: 
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 Zona 3. Barrios del norte de Bucaramanga 

 

Tabla 2. Estudio de Microzonificación Sísmica de Bucaramanga (Zona 3) 

 

Fuente: INGEOMINAS, junio 2001, director Adolfo Alarcón Guzmán 

 

 Zona 4 parte central y sur de Bucaramanga 

 

Tabla 3. Estudio de Microzonificación Sísmica de Bucaramanga (Zona 4) 

 

Fuente INGEOMINAS, junio 2001, director Adolfo Alarcón Guzmán 
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 Zona 5 parte oriental de Bucaramanga 

 

Tabla 4. Estudio de Microzonificación Sísmica de Bucaramanga (Zona 5) 

 

Fuente: INGEOMINAS, junio 2001, director Adolfo Alarcón Guzmán 

 

Luego de analizar estos resultados de los estudios se decidió trabajar con arenas 

y arcillas que son los dos tipos de suelo que son los más se presentan en la 

ciudad   

 

2.3.3 Comportamiento de acción-reacción de la tubería 

 

Figura 4. Diagrama de Cuerpo Libre de la tubería. 

 

Fuente: www.ads-chile.com,  ficha técnica 2.130, Burns & Richard 

http://www.ads-chile.com/
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DONDE: 

 (Pr) es La presión radial del suelo 

 (w)  la deflexión radial (incrementada al doble para proporcionar la deflexión 

total) 

 (v) la deflexión tangencial  

 (N) el empuje circunferencial de la pared 

 (M) el momento de flexión de la pared.  

 

De éstos resultados se generan, el esfuerzo de compresión del aro, los esfuerzos 

de flexión de la pared interior, los esfuerzos de flexión de la pared exterior, el 

esfuerzo total (paredes interiores y exteriores;  el esfuerzo de compresión de la 

pared, el acortamiento del aro, la deflexión vertical total, la deflexión horizontal 

total, y el acortamiento circunferencial. 

 

 CONDICION DE ZANJA Y CARGA SOBRE LA TUBERIA 

 

Es muy importante comprender como se encuentra la tubería y bajo qué 

condiciones, porque estos parámetros nos permiten obtener respuestas sobre el 

comportamiento de la tubería ante eventos sísmicos; la figura 5 nos muestra las 

condiciones de colocación de una tubería enterrada, y la figura 6 nos permite ver, 

de manera general como sería la discretización e interacción de carga sobre el 

suelo y la tubería.   
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Figura 5. Sección Transversal de la Tubería Enterrada. 

 

Fuente: www.google.com/interaccionsuelotuberia/link1. 

 

Figura 6. Discretización de la Tubería y el Suelo 

 

Fuente: www.google.com/interaccionsuelotuberia/link1. 

 

En el diseño de las tuberías enterradas es muy importante la carga que soportara 

la tubería debido al relleno que se coloca sobre la clave del tubo.  

Esta carga no solo se distribuye al tubo sino que también hacia las paredes 

verticales de la zanja y es donde se produce esa interacción suelo tubería. 

La carga de relleno que actúa sobre la tubería se calcula mediante la siguiente 

expresión: 

                                        𝑷 = 𝜸𝑯𝑹 + 𝑷𝒐                                                   (2)   

  

 

http://www.google.com/interaccionsuelotuberia/link1
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Donde: 

 

P: Presión debida al peso del suelo, a la profundidad HR incluida la Presión por 

Carga Viva 

Po(kg/m2). 

 

: Peso específico del suelo (kg/m3). 

 

HR: Profundidad del relleno sobre la corona del tubo (m). 

 

Po: Carga viva por vehículo de eje simple (kg/m2). 

 

En la figura 6, la carga viva se considera en 957 kg/m2 para un vehículo de eje 

simple que transita sobre el terreno del tendido de la tubería a la profundidad HR = 

2.0 m. 

 

Además la carga de relleno produce un esfuerzo de compresión en las paredes 

del tubo que se obtiene con la expresión: 

 

𝝈𝒄 =
𝟗.𝟖𝟏𝑷𝑫

𝟐∗𝟏𝟎𝟎𝟎𝑨
   (3) 

 

Donde: 

: Esfuerzo de compresión en la pared del tubo (kN/m2). 

A: Área de sección de la pared del perfil por unidad de longitud (m2/m). 

D: Diámetro de exterior de la tubería (m). 

 

Este esfuerzo de compresión no debe sobrepasar el smáx de compresión en la 

tubería, por lo tanto el factor de seguridad al límite de este esfuerzo en la pared 

es: 
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𝒏𝒄𝒓𝒖 =
𝝈𝒎𝒂𝒙

𝝈𝒄
> 2  

(4). 

 

NOTA: este parámetro se analizó para indicar la importancia de la condición de 

zanja y carga sobre la tubería, pero en nuestro análisis no lo tenemos en cuenta 

debido a que es una de las hipótesis que el artículo en comparación “Seismic 

behavior of a buried gas pipeline under earthquake excitations” no considera, 

(la carga viva sobre la superficie es ignorada) puesto que solo se remite a la 

influencia del sismo. 
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3. MODELOS MATEMATICOS 

 

 

La existencia actualmente de diversos modelos de análisis matemáticos, que 

reproducen comportamientos estructurales complejos, con ecuaciones 

constitutivas no lineales e incluyendo una geometría que también es expresada 

como no lineal; nos permite analizar el problema a investigar y conocer los 

parámetros que van a gobernar dicho problema. 

 

Con estos modelos se puede obtener de forma aproximada ciertos resultados los 

cuales pueden llegar a ser muy cercanos con respecto a ensayos de laboratorio 

como: (cargas máximas, deformaciones, reacciones o estados tensiónales, etc,) 

para poder adoptar el esquema de instrumentación más adecuado en cada 

experimento, y permiten hacer una comparación de sus resultados con los 

producidos empíricamente. 

 

 

3.1 MÉTODO DE ELEMENTOS LINEALES CON FORMULACIÓN CUBICA 

INELÁSTICA 

 

Es un método novedoso que pretende una nueva discretización de los elementos 

que componen un sistema. Está basado en el método de elementos finitos el cual 

permite reproducir comportamientos estructurales complejos con ecuaciones 

constitutivas no lineales, e incluyendo la no linealidad tanto del material como 

geométrica; dicho estudio debe hacerse mediante la utilización de un modelo 

numérico que tenga en cuenta todas las variables que intervienen en el problema, 

por esta razón se  utilizó el software SEUZ.NL y también porque el articulo en 

comparación (“Seismic behavior of a buried gas pipeline under earthquake 

excitations”) lo aplicó. En la parte analítica indica que el método necesita mínimo 
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tres puntos de referencia para evaluar un elemento.  ZEUS.NL presenta el método 

de elementos finitos, al cual se le aplican los tipos y modificaciones necesarias 

para la implementación del análisis en curso. 

 

Elementos finitos tipo viga: 

 

En la teoría de vigas se desarrolla una aproximación unidimensional del continuo 

en tres dimensiones; esto es debido a que la sección transversal es mucho más 

pequeña en comparación a su sentido longitudinal, por este motivo los análisis 

pertinentes se hacen de una manera desacoplada; esto procura un análisis más 

sencillo, se han utilizado elementos de viga cúbicos de dos nodos, el primer y 

segundo punto identificados en la figura7, como N121 y N221 respectivamente, 

definen la línea en la cual se encuentra el elemento, en este caso la tubería con su 

nombre SIETE y el tercer punto me indica un plano de coordenadas en el cual se 

desarrolla la discretización, este se identifica como NSN1001; y es un nodo no 

estructural. 

 

Figura 7. Elemento lineal con Formulación cubica Inelástica. 

 

Fuente: ZEUS.NL 
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En cuanto a la parte cuantitativa el método trabaja con ecuaciones de Euler 

Bernoulli, de tercer grado para una mejor aproximación. Las cuales no tienen en 

cuenta la deformación transversal por  cortante, es decir que las secciones planas 

perpendiculares al eje de la viga permanecen planas y perpendiculares a dicho eje 

después de la deformación, con esto corroboramos una vez más que el análisis 

desacoplado es necesario debido al plano de deformación del elemento tipo viga.  

 

En estos elementos la integración longitudinal se realiza con una cuadratura de 

gauss a lo largo del eje del elemento y la integración seccional se realiza con 100 

puntos de monitoreo. [Ref. Manual SEUZ.NL] 

 

El software también presenta gráficas de esfuerzo vs tensión de diferentes 

materiales, realizando así un análisis para el rango elasto-plástico del material 

mostrando la no linealidad del mismo. 

 

La siguiente grafica muestra dicho análisis. 

 

Figura 8. Modelo bilineal Elasto-plástico del material. 

 

Fuente: [Ref. Manual SEUZ.NL] 
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3.2 MÉTODO DE WINKLER  

 

Winkler propone que la deflexión, w, en cualquier punto de la superficie del suelo 

de soporte es linealmente proporcional a la presión de contacto que en ese punto, 

e independiente de los esfuerzos de contacto en otros puntos (esto es, el suelo de 

soporte consiste en un sistema de elementos resortes lineales mutuamente 

independientes como se muestra en la fig. (9), es decir: 

 

                                         𝒒(𝒙, 𝒚)  =  𝒌𝟏 𝒘(𝒙, 𝒚)                                           (5) 

 

Donde: k1= módulo de balasto del suelo o medio soportante (su unidad es 

esfuerzo por unidad de longitud). En este modelo los desplazamientos de una 

región cargada uniformemente serían constantes, independientes si la viga es 

infinitamente flexible o infinitamente rígida, como lo muestra las figura 9(en la parte 

a y b respectivamente). La inhabilidad de este modelo para deformarse fuera del 

área cargada restringe su aplicabilidad a los suelos o medios con alguna cohesión 

o con capacidad a cortante. Sin embargo, existen muchos problemas en la 

ingeniería para los cuales este modelo representa una idealización adecuada y 

precisa de las condiciones de soporte existentes, tales como miembros flotantes 

(vigas, entramados, capas de hielo) los cuales son una consecuencia simple del 

principio de Arquímedes. 
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Figura 9. Modelo del Método de Winkler. 

 

Fuente: www.google.com/metododefundacioneswinkler/link4 

 

 

3.3 REPRESENTACION DEL MODELO DEL SUELO  

 

En este estudio debemos tener en cuenta el fenómeno de transmisibilidad de 

esfuerzos entre materiales. Sabemos que la onda viaja por el suelo en donde se 

encuentra instalada la tubería, de modo que éste transmite a la tubería toda la 

fuerza producida por el sismo. Para calcular las propiedades de estos resortes que 

representaran el suelo con el método expuesto en el Manual del American 

LifeLines Alliance [Ref.8], estas expresiones  para la fuerza máxima de los 

resortes que  representaran el suelo se basan en investigaciones en laboratorio y 

experimentos en campo de la respuesta de las  tuberías, así como en los 

enfoques generales geotécnicos  de las estructuras relacionadas, tales como: 

pilas, anclajes de placas integradas y zapatas. Para facilitar su uso en la hoja de 

cálculo u otras aplicaciones por ordenador. 

  

 Resorte Axial: La fuerza axial máxima (Tu), por unidad de longitud que el 

suelo transmitiría a la tubería estaría dada por las ecuaciones: 
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𝑻𝒖 = 𝝅𝑫𝜶𝒄 + 𝝅𝑫𝑯𝜸
𝟏+𝑲𝟎

𝟐
𝒕𝒂𝒏𝜹  (6) 

𝜶 = 𝟎. 𝟔𝟎𝟖 − 𝟎. 𝟏𝟐𝟑𝒄 −
𝟎.𝟐𝟕𝟒

𝒄𝟐+𝟏
+

𝟎.𝟔𝟗𝟓

𝒄𝟑+𝟏
  (6-1) 

 

DONDE: 

 

 (Tu) es la fuerza axial máxima.  

 (D)  es el diámetro exterior del tubo. 

 (C)  es la cohesión del suelo. 

 (H)  es la distancia a la tubería central. 

 (ỹ)  es el peso de la unidad efectiva de la tierra.  

 (K0)es el coeficiente de la presión en reposo. 

 (α)  es el factor de adherencia. 

 (δ)  es el ángulo de fricción en la interfaz de la tubería y el suelo (=fΦ). 

 (Φ) es el ángulo de fricción interna del suelo, y  f es un factor 

(aproximadamente igual a 0,8 para el acero en bruto). 

 

Los  desplazamientos (Δtu) producidos por (Tu) se encontrarían en un rango más 

o menos de 3 mm, 5 mm y 10 mm para la arena densa, arena suelta y arcilla 

blanda, respectivamente, como se sugiere por la Alianza Americana de 

Lifeline.[Ref.8]. 

 

 Resorte Transversal: La fuerza transversal máxima (Pu), por unidad de longitud 

que el suelo transmitiría a la tubería estaría dada por la ecuación: 

 

𝑷𝒖 = 𝑵𝒄𝒉𝑪𝑫 + 𝑵𝒒𝒉𝜸𝑯𝑫  (7)  

𝑵𝒄𝒉 = 𝒂 + 𝒃𝒙 +
𝒄

 𝒙+𝟏 𝟐
+

𝒅

 𝒙+𝟏 𝟑
≤ 𝟗  (7-1) 

𝑵𝒒𝒉 = 𝒂 + 𝒃 𝒙 + 𝒄 𝒙𝟐 + 𝒅 𝒙𝟑 + 𝒆(𝒙𝟒)  (7-2) 
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DONDE: 

 (Pu) es la fuerza transversal máxima. 

 (Nch) y ( Nqh) son el factor de capacidad de carga horizontal, en las arcillas 

(Cero para c = 0) y  en arenas (cero para Φ= 0), Respectivamente, y pueden 

determinarse en función del ángulo de fricción interna, y el valor de (x)= 

H/D.[Ref.8] 

 

El desplazamiento (Δpu) producido por (Pu) puede ser determinado por: 

 

∆𝒑 = 𝟎. 𝟎𝟒(𝑯 +
𝑫

𝟐
) ≤ 𝟎. 𝟏𝑫~𝟎. 𝟏𝟓𝑫   (8) 

 

 Resorte Vertical: La ecuación para la determinación de la fuerza vertical 

ascendente (Qu), producida por el suelo a la tubería por unidad de longitud 

está dada por la ecuación: 

 

𝑸𝒖 = 𝑵𝒄𝒗𝑪𝑫 + 𝑵𝒒𝒗𝜸𝑯𝑫  (9) 

𝑵𝒄𝒗 = 𝟐 
𝑯

𝑫
 ≤ 𝟏𝟎  (9-1) 

𝑵𝒒𝒗 =  
∅𝑯

𝟒𝟒𝑫
 ≤ 𝑵𝒒  (9-2) 

𝑵𝒒 = 𝐞𝐱𝐩 𝝅𝒕𝒂𝒏∅ 𝒕𝒂𝒏𝟐(𝟒𝟓 +
∅

𝟐
)  (9-3) 

 

DONDE: 

 (Qu)   es la fuerza vertical ascendente. 

 ( Ncv) es el factor de elevación vertical de arcilla (cero para c = 0) 

 ( Nqv) es el factor de elevación vertical de arena (cero para Φ = 0) 

 

Los desplazamientos correspondientes (Δqu) producidos por (Qu), se calculan a 

0.01H, 0.02H y 0.2H; en arena densa, arena suelta y arcilla blanda 

respectivamente. [Ref.8]  
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4. PROGRAMA COMPUTACIONAL 

 

 

4.1 SEUZ NL. 

 

Zeus Non linear (ZeusNL) provee una fácil y eficiente forma para realizar análisis 

no lineales dinámicos de tiempo-historia, presiones variables y convencionales; y 

análisis de eigenvalores. A diferencia de otros paquetes de análisis similares, el 

análisis dinámico básico es una cuestión de pasos simples, usando un entorno 

completamente visual. A continuación se presentan las principales características 

del programa. 

 

4.1.1 Características del Programa 

 

 Interfaz completamente visual. No hay archivos de entrada de configuración o 

secuencias de programación  

 Completo control sobre la adición, modificación y eliminación de materiales, 

secciones tipo, nodos, elementos, restricciones y cargas. 

 Seis diferentes tipos de análisis: dinámico y tiempo-historia, adaptativo y 

convencional de pushover, eigenvalores y estático con carga no variable. 

 El programa cuenta tanto con materiales como geometrías no lineales. 

 Modelos de materiales precisos y probados para el acero y para el concreto 

 Una gran variedad de secciones compuestas tanto de concreto reforzado como 

de acero 

 La propagación inelástica a lo largo de la longitud del miembro y a lo profundo 

de la sección transversal es modelada explícitamente en ZeusNL permitiendo 

un estimación precisa de la acumulación de daños. Esta función establece una 

diferencia de ZeusNL con las demás herramientas que usan inelasticidad 

lamped para modelar el comportamiento de miembros no lineales. 
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 Alta estabilidad y precisión a niveles muy altos de tensión lo que permite la 

precisa determinación de la carga de colapso de las estructuras. 

 La carga aplicada puede consistir de fuerzas constante o variables, 

desplazamientos y aceleraciones en los nodos. La carga variable aplicada 

puede variar proporcionalmente o independientemente en el pseudo dominio 

del tiempo. 

 La innovación del procedimiento de Pushover adaptativo. En esta método de 

pushover, la carga distribuida lateral no permanece constante. Pero se 

actualiza constantemente durante el análisis de acuerdo a las formas modales 

y factores de participación derivados de un análisis de eigenvalores realizado 

durante el paso actual. De esta manera, el estado de la rigidez y la elongación 

del periodo de la estructura en casa paso, así como los altos efectos de la 

forma modal, son tenidos en cuenta. 

 La integración con el entorno del sistema operativo Windows®. Los datos 

puede ser pegados a las tablas de ingreso de datos de ZeusNL desde los 

programas de hojas de cálculo, como Microsoft® Excel; y todo lo que 

aparecerá en las ventanas de Zeus.NL se puede copiar de regreso 

nuevamente (por ejemplo a programas de procesamiento de texto como 

Microsoft® Word), Incluido el ingreso y salida de datos, graficas de alta calidad, 

los modelos de las formas Deformadas y no deformadas y más. Más aun, 

películas en formato AVI pueden ser creados describiendo la secuencia de las 

formas deformadas de la estructura. 

 Gestor de plantillas templates, el usuario puede crear modelos regulares o 

irregulares en 2D o 3D y correr todo tipo de análisis en unos cuantos 

segundos. 

 Avanzados post-procesos facilita los gráficos derivados y las formas modales 

fácil y eficientemente. 

 El software presenta una versión libre y renovable anualmente. 
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4.2 METODOLOGÍA Y ORIENTACIÓN DEL SOFTWARE 

 

4.2.1 Capacidades Técnicas 

 

Zeus NL se puede utilizar para predecir las longitudes de desplazamiento de 

marcos en 2D y 3D bajo cargas estáticas o dinámicas, teniendo en cuenta el 

comportamiento no lineal de ambos, en la geometría y los materiales. Están 

disponibles los modelos de materiales como el concreto y el acero, ambos con una 

amplia librería de elementos en 3D que pueden ser usados como: tuberías, 

hormigón y configuraciones de secciones compuestas. La carga aplicada puede 

ser constante o variable respecto a las fuerzas, aceleraciones y desplazamientos. 

 

Zeus NL tiene la capacidad de realizar análisis de: valores propios, cargas 

estáticas, estático de tiempo-historia y análisis dinámicos como sigue: 

 

 Análisis de Valores Propios Se usa el eficiente algoritmo de Lacnoz es usado 

para la evaluación de las frecuencias naturales de la estructura y las formas 

modales 

 Análisis Estático de Empujes (Convencional y adaptativo) En el análisis 

convencional de cargas estáticas. La carga aplicada (desplazamientos, cargas 

o una comb|1 el usuario hace click en algunas de las ventanas de ZeusNL. 

Estos menús permiten la ejecución rápida y fácil de las funciones más 

utilizadas. Los menús emergentes están atados a todas las tablas y diagramas 

de ZeusNL.  

 Análisis Estático de Tiempo Historia La carga aplicada (desplazamiento, 

fuerzas o una combinación de ambos) varia independiente en el pseudo 

dominio del tiempo, de acuerdo a un patrón prescrito. 

 Análisis Dinámico La carga aplicada generalmente es la aceleración en los 

apoyos  (aunque también se pueden usar fuerzas). Se puede modelar tanto 
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excitaciones simétricas como asimétricas. Se puede emplear tanto el algoritmo 

de Hilbert-Hughes como el algoritmo de Integración de Newmark. 

 

4.2.2 Convenciones  

 

Hay un número de términos y convenciones usados en este manual con los que el 

usuario deberá familiarizarse: 

 

 Comandos: Por ejemplo, Nombre del Menú > Nombre del Comando, así como 

File >Save, que quiere decir “abra el menú File y de click en el comando Save”. 

 Modelo: El modelo de la estructura que es creado con ZeusNL. Incluye la 

completa descripción de la estructura desde los materiales y tipos de 

secciones, hasta los nodos, los elementos y las restricciones. 

 Windows®: Aquí nos referimos a la línea de productos de Microsoft Windows®; 

que son Windows® 95/98, Windows® Me, Windows® NT, Windows® 2000, 

Windows® XP, Windows® Vista, Windows® 7; note que el programa no es 

soportado por sistemas Windows® 3.1 o anteriores. 

 Proyecto: Esto se refiere al conjunto de archivos y opciones que son usadas en 

ZeusNL para cualquier análisis. Los archivos de datos ingresados en ZeusNL 

son salvados y se cargan con la extensión .dat. Sin embargo existen otros tipos 

de archivos creados durante la formación del modelo (por ejemplo; los archivos 

de datos de curvas .crv que describen la carga del modelo de la estructura).  

 Cuadros de Dialogo: Estos son las ventanas que se abren para el ingreso de 

datos. El usuario entonces ingresa los datos requeridos y da click en OK para 

aceptar los datos a ingresar o da click en Cancel para cancelar la operación. 

 Menús Emergentes: Son menús de atajo que aparecen cuando el usuario da 

click derecho en partes de la ventanas de ZeusNL. Estos menús están 

disponibles para ejecutar fácilmente las funciones más comúnmente utilizadas. 

Menús emergentes están atados a todas las tablas, ventanas y diagramas de 

ZeusNL. 
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4.2.3 Requerimientos Del Sistema 

 

La siguiente tabla muestra los requerimientos para usar ZeusNL. 

 

Tabla 5. Requerimientos de Sistema para ZeusNL. 

Parte Requerimiento 

Procesador Pentium III o superior 

RAM 64 MB o superior (128 es lo recomendado) 

Disco Duro 

11 MB de espacio libre para la instalación; sin 

embargo, para ejecutar los proyectos con 

grandes modelos (cientos de nodos), 

especialmente en análisis tiempo-historia 

pueden resultar archivos extremadamente 

grandes, en algunos casos de mas de 100MB 

Adaptador 

de Video 

Adaptador grafico que soporte el sistema 

operativo Windows® 

Sistema 

Operativo 

Windows® 95/98, Windows® Me, Windows® 

NT, Windows® 2000, Windows® XP, Windows® 

Vista, Windows® 7 

Fuente: manual SEUZ.NL 

 

4.2.4 Instalando Zeus 

 

 Inicie el sistema operativo Windows® 

 Inserte el CD-ROM de instalación en la unidad de CD 

 Normalmente el Set-Up del programa arrancara automáticamente. Sino ocurre 

abra los contenidos del CD y corre el ejecutable. 
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 Sigue las instrucciones y el programa de instalación automatizado procederá a 

copiar ZeusNL en el disco duro. Normalmente, la configuración sugerida por el 

instalador debería funcionar bien. Se crearan archivos de acceso rápido se 

agregaran al escritorio y al menu > start abajo en Programs > ZeusNL. 
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5. MODELAMIENTO 

 

 

5.1 METODOLOGÍA 

 

Explicaremos paso a paso como es el desarrollo de un modelo, las propiedades 

de cada material y otras características; al tiempo se  explicara un montaje 

realizado con el software  para una arena densa, los siguientes modelos se 

desarrollan de la misma manera, con los datos correspondientes para cada uno. 

 

Figura 10. Metodología Para el Desarrollo del Proyecto. 

 

Fuente: los Autores del proyecto. 
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5.2 SELECCIÓN DE LOS MATERIALES Y PROPIEDADES PARA EL MODELO 

 

5.2.1 Tubería 

 

En este estudio se uso un tipo de tubería de acero al carbón que se empleó en la 

construcción de un gasoducto ubicado en la sección Payoa – Bucaramanga 

llegando al palenque en Girón; [Ref.11] se usa este tipo de material  dado que el 

software utilizado maneja este tipo de tuberías de acero, la tubería seleccionada 

tiene la denominación API-5LX42 que posee las siguientes propiedades: 

 

Figura 11. Propiedades de la Tubería API-5LX42. 

 

Fuente: www.codiacero.com [Ref.12] 

 

Se trabaja una tubería de 8” que es la que se encuentra instalada en este 

gasoducto. 
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Figura 12. Dimensiones de la Tubería Seleccionada. 

 

Fuente: www.codiacero.com[Ref.12] 

 

Tenemos las siguientes propiedades: 

 Diámetro externo: 219.1mm 

 Espesor de pared: 12.7 mm 

 Modulo de Young: 289000 N/mm2 

 Resistencia a la fluencia: 413 N/mm2 

 Peso por unidad de longitud: 64.64 Kg/m 

 Parámetro de endurecimiento: 0.00 

 

5.2.2 Capacidad de la tubería enterrada 

La siguiente Tabla  muestra la capacidad de la tubería enterrada, calculada tanto 

para la deformación admisible como para los desplazamientos en las direcciones 

axial y transversal, proporcionada por el artículo en comparación. [Ref. 10, Manual 

Kogas] 
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Tabla 6. Deformaciones y Desplazamientos Admisibles. 

Deformación 

Admisible 

Capacidad de Desplazamiento (mm) 

Dirección Axial Dirección Transversal 

6.98E-03 3874.4 (1936.7) 2106.3 (351.05) 

Fuente: article “Seismic behavior of a buried gas pipeline under earthquake excitations”, [Ref.3] 

 

5.2.3 Representación del suelo. 

  

Se tiene en cuenta el estudio de suelos para la ciudad de Bucaramanga 

desarrollado por ingeominas; el cuál estratifica la ciudad en zonas dependiendo de 

la velocidad de propagación de ondas, tomamos la zona 3 y 5 del estudio, en las 

cuales se encuentran suelos arcillosos y arenas densas respectivamente. 

 

Estas zonas han sido seleccionadas para obtener conclusiones en base a los tipos 

de suelos utilizados en el artículo, con el fin de establecer un criterio, sobre el 

comportamiento de nuestras tuberías de gas. 

 

Las propiedades de estos suelos y los valores  medios del peso específico seco se 

seleccionan para estos tipos de suelo como se ve en la tabla 7, que son de vital 

importancia para incluir en las ecuaciones del capítulo 3, así poder desarrollar la 

representación del suelo como resortes por el modelo de winkler.  
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Tabla 7. Propiedades de los Suelos. 

Tipo de suelo 

Relación de 

vacios 

Contenido de agua 

natural 

Peso especifico 

seco (γd) 

E 

En condición 

saturada (%) 
[lb/pie3] [Kn/m3] 

Arena suelta 0.8 30 92 14.5 

Arena densa 0.45 16 115 18 

Arena limosa 

suelta  
0.65 25 102 16 

Arena limosa 

densa 
0.4 15 120 19 

Arcilla dura 0.6 21 108 17 

Arcilla suave 0.9-1.4 30-50 73-92 11.5-14.5 

Loes 0.9 25 86 13.5 

Arcilla orgánica 

suave 
2.5-3.2 90-120 38-51 06-ago 

Morrena glacial 0.3 10 134 21 

Fuente: (Mecánica de Suelos, Braja Dass) Ref [13] 

 

Además se usan los ángulos de fricción internos reportados en el articulo “Seismic 

behavior of a buried gas pipeline under earthquake excitations” que son de 35° 

para la arena densa y de 0° para la arcilla. 

 

Con estas propiedades se usa una hoja de cálculo para hallar la rigidez de los 

resortes que representan el suelo usando las ecuaciones mostradas en el capítulo 

3. 
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Tabla 8. Propiedades de los Resortes Representativos de los Suelos. 

RIGIDEZ DE LOS RESORTES POR UNIDAD DE LONGITUD 

    Axial Transversal Vertical 

Arena Densa Rigidez por unidad de longitud 23.95 129.35 51.24 

  D0 desplazamiento  3 80 18.9 

Arena Suelta Rigidez por unidad de longitud 16.94 40.1 29.48 

  D0  desplazamiento 5 80 18.9 

Arcilla Blanda Rigidez por unidad de longitud 24.48 26.51 0.03 

  D0 desplazamiento 10 80 378.09 

Fuente: los Autores del proyecto. 

 

5.2.4 Perfil del Tramo de Tubería 

 

El estudio de tubería se desarrolla a una profundidad de 1.881m que es muy 

similar a la profundidad de enterramiento de nuestras tuberías y considerando 

tramos rectos de 1.2 km como se muestra en la figura 13, para efectos de 

comparación. [Ref.3] 

 

Para los extremos se trabajan las tres condiciones tratadas en el articulo “Seismic 

Behaivor Under Earthquake Exitacions”; [Ref.3]  que son empotrado-empotrado, 

empotrado-articulado, articulado-articulado  en busca de mantener la concordancia 

en el estudio y poder comparar los resultados obtenidos. 
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Figura 13. Perfil del Modelo de Tubería. 

 

Fuente: los Autores del proyecto. 

 

5.2.5 Acelerogramas de sismos 

 

Los dos acelerogramas empleados en el artículo “seismic behavior of a buried gas 

pipeline under earthquake excitations”. Del sismo de hyogo-ken nanbu en 1995 

japón (estación kobe), [Ref.7]. 

 

Se observan en las figuras 14 y 15 los acelerogramas en la dirección axial y 

transversal respectivamente. Tomados como tablas de valores de la [Ref.7] y 

presentados gráficamente con el programa SEUZ.NL. 
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Figura 14. Registro de Acelerograma en dirección axial. 

 

Fuente: [Ref.7], programa SEUZ.NL. 

 

Figura 15. Registro de Acelerograma en dirección transversal. 

 

Fuente: [Ref.7], programa SEUZ.NL. 

 

5.2.6 Montaje en el Software Seleccionado. 

 

Explicaremos paso a paso como se desarrollo el modelo para una arena densa, 

los siguientes modelos se desarrollan de la misma manera, con los datos 
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correspondientes para cada uno. 

 

En cuanto a los otros modelos, presentaremos junto con el primero un análisis de 

resultados que fueron evaluados de igual manera. 

 

Los montajes se hicieron en el programa ZEUS.NL. de la siguiente manera: 

1. Al abrir el programa lo primero que se debe tener en cuenta son las unidades 

de trabajo, en este caso la fuerza se debe estar en [N] y la longitud en [mm]. 

2. En la barra de herramientas se debe escoger el análisis que se desea utilizar, 

para este caso utilizaremos un análisis dinámico de tiempo-historia.  

 

Figura 16. Pantalla Inicial del Programa. 

 

Fuente: SEUZ.NL. 

 

3. plantilla o template: el cual proporciona una visualización de la estructura a 

analizar, en conjunto se define el acelerograma a utilizar. Nota: todos estos 

datos son modificables luego se puede saltar este paso. 
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Figura 17. Definición de la plantilla. 

 

Fuente: SEUZ.NL. 

 

Figura 18. Definición de la estructura. 

 

Fuente: SEUZ.NL. 

 

En el caso de seleccionar trabajar desde la plantilla se debe ingresar el 

sismo con el que se va a trabajar. 
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Figura 19. Definición de acelerograma. 

 

Fuente: SEUZ.NL. 

 

4. Materiales: agregamos el tipo de material y el nombre del mismo. Utilizando el 

método bilineal elasto-plástico que el software tiene en su librería para hacer el 

análisis. Como se especificó en el numeral 3.1 en la figura 8. 

 

Figura 20. Selección del material. 

 

Fuente: SEUZ.NL. 
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5. Sección: Se agrega el nombre y tipo de sección transversal, enlazado al 

material utilizado. 

 

Figura 21. Tipo de sección transversal. 

 

Fuente: SEUZ.NL. 

 

6. Elementos de clase: Se crean tres tipos de elementos de clase, de los seis 

que dispone la librería del programa;( cubic, joint, Imass, dmass, ddamp, 

rdamp),  para este análisis:  

 Cubico: el cual nos representa el modelo de elementos de línea con 

formulación cubica inelástica. 
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Figura 22. Elección del elemento de clase para la tubería. 

 

Fuente: SEUZ.NL. 

  

 Junta: este elemento de clase nos permite modelar el suelo por medio de 

resortes helicoidales no lineales en tres dimensiones, esto nos representa 

el modelo de fundaciones de winkler. Y además es el medio por el cual se 

presenta la interacción suelo estructura. Nota: las juntas se representan en 

coordenadas locales, se indica para el paso 8, en el cual los nodos de la 

estructura deben conectarse en coordenadas locales para su 

representación. 
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Figura 23. Elección del elemento de junta para representar el suelo. 

 

Fuente: SEUZ.NL. 

 

 Masa: Se presenta con dos componentes ya que puedo agregar la masa 

del sistema tanto distribuida como concentrada, permitiendo el desacople 

para el análisis de resultados. Se opto este modelo de masa concentrada 

porque para hacer una comparación en ciertos puntos del sistema es más 

consistente debido al desacople del mismo.   
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Figura 24. Representación de la masa del sistema. 

 

Fuente: SEUZ.NL. 

 

7. Nodos: en este paso si utilizó el paso 3. Hay que hacer las modificaciones 

necesarias para el montaje geométrico de la estructura, teniendo en cuenta 

todos los pasos definidos anteriormente, si no se utilizó el paso 3, entonces 

solamente hay que anexar los nodos que me definen la geometría de la 

estructura. Nota: estos nodos pueden ser estructurales y no estructurales 

dependiendo del sistema como se trato anteriormente. 
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Figura 25. Nodos de la estructura. 

 

Fuente: SEUZ.NL. 

 

8. Elementos de conectividad: al tener todos los nodos que representan el 

sistema, estos se deben conectar; para este paso se debe tener en cuenta el 

paso 6, ya que este me provee la clase de elemento que quiero para conectar 

dos nodos. 

 

Figura 26. Conectividad de los elementos. 

 

Fuente: SEUZ.NL. 
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9. Restricciones: Se definen cuales nodos deben ser liberados o atados para 

obtener resultados en las direcciones requeridas por el análisis teniendo en 

cuenta su sistema de coordenadas globales. Nota: el software indica que hay 

que liberar los nodos en la dirección en que se dirige el sismo con sus debidas 

componentes. 

 

Figura 27. Restricciones de la tubería en los extremos. 

 

Fuente: SEUZ.NL. 

 

10. Curvas tiempo-historia: en este paso se agregaron las curvas de los 

acelerogramas en función del tiempo requeridas para el análisis; en este caso 

los acelerogramas de los sismos de northridge y kobe respectivamente. 
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Figura 28. Menú de curvas de carga donde se agregan los acelerogramas. 

 

Fuente: SEUZ.NL. 

 

11. Aplicación de carga: ZEUS.NL. presenta una librería de aplicación. (anexo: 

manual del programa). En el estudio la carga la proporcionaba el sismo, 

entonces se cargaron con las aceleraciones del mismo; los respectivos nodos 

de análisis con su respectiva dirección. Nota: hay que tener en cuenta las 

unidades en las que se encuentra el acelerograma en la base de datos, ya que 

al montarlo en el programa, este tiene un factor de conversión preestablecido. 

 



72 

Figura 29. Cargas y dirección de aplicación. 

 
Fuente: SEUZ.NL. 

 

12. Equilibrio de etapas: con este paso culminaríamos con el montaje requerido 

para poner el programa a correr y obtener resultados; Nota: el programa por 

defecto asume este equilibrio para puntualizar el análisis tiempo-historia y 

agrupar el sistema en estudio. Este análisis depende de la duración y el paso 

del sismo. 

 

Figura 30. Insertando las etapas. 

 
Fuente: SEUZ.NL. 
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13. Correr: el programa compila los datos y efectúa un análisis iterativo para 

enviar resultados, los cuales se muestran como: (archivos.num), que son 

necesarios para ingresar al post procesador y al visor de forma deformada, que 

se encuentran en la barra de herramientas al lado del icono correr; en donde 

se muestran los resultados del análisis. 

 

Figura 31. Ejecución del programa. 

 

Fuente: SEUZ.NL. 

 

14. Post-procesador: con este paso se tiene una gran cantidad de análisis que el 

programa efectúa, encontramos desplazamientos, fuerzas en los nodos o en 

los elementos, cortantes, momentos y se pueden visualizar estos análisis por 

medio de gráficos ya que son tabulados.  
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Figura 32. Menú del post- procesador. 

 

Fuente: SEUZ.NL. 

 

15. Visor de forma deformada: este paso presenta una imagen de la 

estructura deformada en cada instante de tiempo, es importante saber en la 

discretización del tiempo como es el comportamiento de la estructura.  

 

Figura 33. Menú de forma deformada. 

 

Fuente: SEUZ.NL.  
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6. VERIFICACION DEL MODELO 

 

 

Para dar verificación de los resultados aquí presentados se empleo el artículo 

“seismic behavior of a buried gas pipeline under earthquake excitations” [Ref.3]. 

Se realizaron interpretaciones en el modelo desarrollado en el numeral anterior, 

con base en los estudios realizados  sobre análisis sísmicos de estructuras, suelos 

y su interacción. Los modelos se montaron tratando de llegar a unos análisis 

coherentes dado que en algunas situaciones no se presentaban los datos de una 

forma explícita sino deducible y dependiente de otros parámetros o gráficos que 

se empleaban en el artículo. [Ref. 3] 

 

En este estudio se tuvieron en cuenta dos puntos de comparación: 

 Desplazamientos longitudinales y transversales 

 Capacidad de la tubería enterrada; (desplazamientos y deformaciones 

permitidas por kogas). 

 

Obtenemos los siguientes resultados: 

 

6.1 DESPLAZAMIENTOS LONGITUDINALES Y TRANSVERSALES: 

 

Se presenta una parte de los datos de los desplazamientos en [mm] [tabla 9], tanto 

del suelo como la tubería en función del tiempo, por cuestiones de resumen, 

debido a la gran cantidad de datos ya que el Δt= 0.02 seg; se resalta en rojo el 

desplazamiento máximo de la tubería que se da en un tiempo de 47.54 seg. Que 

es el que se usa para realizar los análisis pertinentes. 
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Tabla 9.  Resultados  de Desplazamientos del Montaje de Verificación. 

 

Fuente: SEUZ.NL. 

 

De esta tabla evaluamos los resultados para obtener los desplazamientos relativos 

entre el suelo y la  tubería en  un mismo punto de análisis: Estos desplazamientos 

se encuentran con la diferencia entre los valores de la tubería y los del suelo 

respectivamente:    n121- n121-x1= 40.8 mm. Encontrando que para cada punto 

de análisis se presenta un valor de desplazamiento relativo constante entre la 

tubería y el suelo en la dirección axial. 

 

6.1.1 Máxima Respuesta al Desplazamiento Relativo de la Tubería en la 

Dirección Axial 

 

Para una condición de empotrado – empotrado, la Gráfica proporcionada por el 

artículo en comparación: donde ST_1K y ST1_N corresponden a los 

desplazamientos bajo los sismos de Kobe y Northridge respectivamente en 

dirección axial.  
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Figura 34. Cuadro Comparativo de Desplazamientos Relativos 

 

Fuente: article “Seismic behavior of a buried gas pipeline under earthquake excitations”, [Ref.3] 

 

Figura 35. Desplazamiento Relativo Arena Densa Sentido Axial. 

 

Fuente: los Autores del proyecto. 
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Figura 36. Desplazamiento Relativo Arcilla blanda Sentido axial. 

 

Fuente: los Autores del proyecto. 

 

6.1.2 Máxima Respuesta al Desplazamiento Relativo de la Tubería en la 

Dirección Transversal. 

 

Para una condición de empotrado- empotrado, la Gráfica proporcionada por el 

artículo en comparación: donde ST_1K y ST1_N corresponden a los 

desplazamientos bajo los sismos de Kobe y Northridge en dirección transversal.  

 

Figura 37. Cuadro Comparativo de Desplazamientos Relativos 

 

Fuente: article “Seismic behavior of a buried gas pipeline under earthquake excitations”, [Ref.3] 
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Figura 38. Desplazamiento Relativo Arena Densa Sentido Transversal. 

 

Fuente: los Autores del proyecto. 

 

Figura 39. Desplazamiento Relativo Arcilla blanda Sentido Transversal. 

 

Fuente: los Autores del proyecto. 

 

Se analizó el desplazamiento máximo relativo de la tubería, en dirección axial y en 

dirección transversal para los dos sismos utilizados teniendo en cuenta: 
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 El tipo de suelo que más se desplaza, en esta condición es la arcilla blanda; 

verificando que cumplan con la norma para tuberías de KOGAS. [Ref.10]. 

 La tubería se encuentra sujeta a una estructura la cuál provee una gran 

resistencia al desplazamiento, es decir que uno de sus extremos esta fijo a otro 

sistema de referencia. 

 Al analizar las respuestas obtenidas notamos que los mayores 

desplazamientos se producen bajo la acción del sismo JMA Kobe, por lo que 

se decide trabajar con este sismo los montajes para los análisis de la ciudad. 
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7. APLICACION EN UN TRAMO DE TUBERIA EN BUCARAMANGA 

 

 

7.1 ANÁLISIS DE RESULTADOS 

 

Para los análisis de los resultados se estudian  primero los desplazamientos de la 

tubería, los desplazamientos totales y los desplazamientos  relativos. En el 

primero de ellos se observa la respuesta general al desplazamiento y con la 

segunda  nos enfocamos más en el comportamiento de la interacción suelo-

tubería.  

  

Con relación a los resultados en los desplazamientos generales se observan altos 

valores para todos los casos lo que nos indica este ítem no parece verse afectado 

por el tipo de suelo en el que se encuentre la tubería; esto no implica que no haya 

una interacción suelo tubería, indica que los desplazamientos en este caso se 

presentan a un nivel más bajo. 

 

Se observa también que los elementos sometidos a empotramiento son los que 

sufren las mayores deformaciones. 

 

En este caso se evidencia que estos elementos  muestran mayor fragilidad; en 

este ítem se nota que se debería estudiar los casos  en que los extremos de la 

tubería se encuentran articulados. 
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7.1.1 Análisis de Desplazamientos Axiales 

 

En los desplazamientos relativos se observan diferencias entre la arena y la 

arcilla, aunque es leve, indica que esta diferencia está dada más por las 

propiedades de la tubería que por resistencia de los suelos. 

 

Para la arcilla como se dijo anteriormente los desplazamientos generales 

muestran datos  que superan los valores máximos permitidos. (Tabla 6. [Ref.3] y 

[Ref.10]) Esto cobra especial cuidado en la condición empotrado-empotrado ya 

que es en estos elementos donde se concentra la mayor parte de la deformación 

causada. 

 

Al analizar los desplazamientos relativos, se observa para la condición articulado-

articulado una disminución en el desplazamiento a partir de la mitad de la tubería. 

 

Para los desplazamientos generales en la arena, se muestran los mismos 

comportamientos que los presentados en la arcilla. En el caso de los 

desplazamientos relativos este desplazamiento no presenta la variación que se 

presento en la arcilla en la condición articulada-articulada. 
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7.1.1.1 Arcilla Blanda. Análisis para considerar las condiciones de restricción.  

 

Figura 40. Desplazamiento Relativo Axial Empotrado-Empotrado. 

 

Fuente: Los Autores del proyecto 

 

Figura 41. Desplazamiento Relativo Axial  Empotrado-Articulado. 

 

Fuente: Los Autores del proyecto 
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Figura 42. Desplazamiento Relativo Axial Articulado-Articulado. 

 

Fuente: Los Autores del proyecto 

 

7.1.1.2 Arena Densa: Análisis para considerar las condiciones de restricción.  

 

Figura 43. Desplazamiento Relativo Axial Empotrado-Empotrado. 

 

Fuente: Los Autores del proyecto 
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Figura 44. Desplazamiento Relativo Axial Empotrado-Articulado. 

 

Fuente: Los Autores del proyecto 

 

Figura 45. Desplazamiento Relativo Axial Articulado-Articulado. 

 

Fuente: Los Autores del proyecto 

 

7.1.2 Análisis de Desplazamientos Transversales 

 

Para la arcilla los desplazamientos transversales muestran un comportamiento 

similar al axial, en el que los desplazamientos totales superan los permitidos, 

(Tabla 6. [Ref.3] y [Ref.10])  y nuevamente la interacción suelo-tubería se presenta 

en niveles pequeños; el caso crítico se presenta en los empotramientos ya que en 

estos puntos es donde se concentra el desplazamiento. 
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Se observa una disminución de los desplazamientos relativos en el caso de la 

condición articulado-articulado a partir de la mitad de la tubería. 

 

Para  la arena los desplazamientos transversales muestran los mismos 

comportamientos de la arcilla pero en este punto se nota una mayor interacción 

suelo-tubería ya que los desplazamientos relativos disminuyen en todas las 

condiciones de los extremos. 

 

7.1.2.1 Arcilla Blanda. Análisis para considerar las condiciones de restricción. 

 

Figura 46. Máximo Desplazamiento Relativo Transversal Arcilla condición 

Empotrado-Empotrado. 

 

Fuente: los Autores de proyecto. 

 

Figura 47.1 Máximo Desplazamiento Transversal Relativo Arcilla condición 

Articulado-Articulado. 

 

Fuente: los Autores de proyecto. 
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7.1.2.2 Arena Densa. Análisis para considerar las condiciones de restricción. 

 

Figura 48. Máximo Desplazamiento Relativo Transversal de la Arena Densa 

condición Empotrado-Empotrado. 

 

Fuente: los Autores de proyecto. 

 

Figura 49. Máximo Desplazamiento Relativo Transversal de la Arena Densa 

Condición Empotrado-Articulado. 

 

Fuente: los Autores de proyecto. 
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Figura 50. Máximo Desplazamiento Relativo Transversal de la Arena Densa 

Condición Articulado-Articulado. 

 

Fuente: los Autores de proyecto. 

 

 

7.2 ANÁLISIS DE DEFORMACIÓN DE LA SECCIÓN TRANSVERSAL DE LA 

TUBERÍA. 

 

Para las tres condiciones de restricción, la Gráfica proporcionada por el artículo en 

comparación corresponde a las deformaciones bajo el  sismo de kobe. 

 

Figura 51. Cuadro Comparativo de las deformaciones Relativas. 

 

Fuente: article “Seismic behavior of a buried gas pipeline under earthquake excitations”, [Ref.3] 
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7.2.1 Deformación Causada por el Sismo en Dirección Axial 

 

Como se esperaría del análisis de los desplazamientos las deformaciones superan 

los máximos permitidos, (Tabla 6. [Ref.3] y [Ref.10]) adicionalmente los puntos 

críticos son los empotramientos. 

 

En este caso las deformaciones son las mismas para los dos tipos de suelos, lo 

que indicaría que no hay influencia de este en la deformación, salvo en le 

condición articulado-articulado donde se observa una leve disminución en la 

deformación en la arcilla. 

 

Figura 52. Deformación máxima de la Sección Transversal condición 

Empotrado-Empotrado. 

 

Fuente: los Autores de proyecto. 
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Figura 53. Deformación Máxima de la Sección Transversal condición 

Empotrado-Articulado. 

 

Fuente: los Autores de proyecto. 

 

Figura 54. Deformación máxima de la Sección Transversal condición 

Articulado-Articulado. 

 

Fuente: los Autores de proyecto. 
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7.2.2 Deformación Causada por el Sismo en Dirección Transversal. 

 

Las deformaciones en la sección de la tubería debido al sismo en dirección 

transversal muestran una dependencia del tipo de suelo en el que se encuentra la 

tubería. En el caso de la arena para la condición empotrado-empotrado las 

deformaciones son mayores que las de la arcilla contrario a lo que ocurre en la 

condición articulado-articulado en la que las deformaciones de la arcilla son 

mayores, en la condición empotrado-articulado se observa un comportamiento 

completamente inverso ya que mientras que en la arena las deformaciones 

máximas disminuyen a lo largo de la tubería en la arcilla estas aumentan.  

 

Figura 55. Deformación Máxima de la Sección Transversal Tubería Condición 

Articulado- Articulado. 

 

Fuente: los Autores de proyecto. 
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Figura 56. Deformación Máxima de la Sección Transversal Tubería Condición 

Empotrado-Articulado. 

 

Fuente: los Autores de proyecto. 

 

Figura 57. Deformación Máxima de la Sección Transversal Tubería Condición 

Empotrado-Empotrado. 

 

Fuente: los Autores de proyecto. 

  



93 

 

8. CONCLUSIONES 

 

 

 Se realizó el montaje de la tubería y se compararon los resultados con el 

articulo de referencia; con la dificultad que no encontramos las mismas 

componentes de los acelerogramas para los terremotos utilizados; sin 

embargo, encontramos valores de desplazamientos y deformaciones, 

coherentes y muy similares tanto para el análisis longitudinal como transversal, 

con esto confirmaríamos la utilidad del programa y la viabilidad de un estudio  

completo para las tuberías en Bucaramanga. 

 Se corrobora que si hay influencia del tipo de suelo al hacer análisis de 

desplazamientos  ya sean longitudinales o transversales, aunque el artículo en 

comparación no considere este parámetro para el análisis longitudinal porque 

los valores que ellos presentan son muy similares y podrían despreciarse, pero 

nosotros si lo tenemos en cuenta ya que se presenta una diferencia de un 20% 

y esto  es notorio para nuestras consideraciones.  

 Los resultados muestran que en el caso de las tuberías de gas enterradas en la 

Ciudad podrían no estar preparadas para un evento sísmico de gran magnitud, 

puesto que las tuberías sufrirían deformaciones relativas mayores a los 

permitidos, en el caso de la arcilla blanda en una condición de empotrado-

empotrado presenta una deformación de 0.015 siendo la permitida 0.000698 

según tabla 6.[Ref.3]  

 Se abre con este trabajo de grado el camino a futuros estudios que profundicen 

y mejoren los modelos que se usaron y que permitan una mejor compresión del  

comportamiento de las tuberías enterradas. 
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ANEXOS 

 

 

ANEXO A. MANUAL PARA ORIENTACIÓN DEL PROGRAMA 

COMPUTACIONAL 

 

Se realizo una traducción al español del manual para facilitar su futuro uso. [Ref.4] 
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Como Usar Este Manual 

 

Este manual explica la operación y las características de ZeusNL. Se ha separado 

en secciones, las cuales le permiten ser usado como guía de referencia, así como 

un tutorial para iniciarse en el uso de esta programa. 

 

Para iniciarse como usuario de este programa, sigua las instrucciones, adelante 

en este capítulo se explicara como instalar ZeusNL. Una vez que esté instalado, el 

resto del programa puede ser explorado  siguiendo los tutoriales paso a paso en la 

Sección 2. Es altamente sugerido el seguir los Tutoriales, para que el usuario 

obtenga un mejor funcionamiento en el menor tiempo posible.[Ref.4] 

 

 

TUTORIALES 

 

Este capítulo encaminara al usuario a través de los primeros tipos de análisis en 

ZeusNL. ZeusNL fue diseñado con dos cosas en mente facilidad de uso y 

flexibilidad. El objetivo es correr análisis en tan solo minutos (incluso análisis 

dinámico de tiempo-historia). Es actualmente más fácil usar ZeusNL de lo que es 

describirlo. Una vez que el usuario se ha familiarizado con algunos conceptos 

importantes, el proceso es bastante intuitivo. 

 

A pesar de que el proceso no tome más que unos minutos, el modelo creado tiene 

muchas características y puede eficientemente y con precisión simular la 

estructura real. Para mucha gente, esto es toda la funcionalidad que necesitaran 

del ZeusNL. En la sección 3 nos adentramos en detalles de todas las potentes 

funciones con que cuenta el ZeusNL y las formas de aumentas su productividad. 
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TUTORIAL 1- ANÁLISIS DINÁMICO 

 

Se supone en lo sucesivo, que el usuario está tratando con un modelo en 3D, de 

una estructura en RC de cuatro pisos y corre un análisis dinámico de tiempo-

historia de un registro específico. Se asume también que la estructura es regular y 

tiene dos luces y consiste de dos marcos paralelos. Las luces son de una longitud 

de 5m, la altura de las placas es de 3m y la distancia entre los dos marcos es de 

4m. [Ref.4]. 

 

Configuración Estructural 

 

Para abrir la ventana de Templates, seleccione File>Creata from templete, menú 

comandos o click en el botón de Templete en la barra de herramientas. Al usuario 

se le presentara una ventana con una todas las opciones concernientes a la 

configuración estructural: 

 

Fig. 1 Pantalla de la Ventana de Plantillas (configuración estructural) 
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 Marco 2D o Marco 3D escoja un marco en 3D. 

 Numero de luces, Placas y marcos seleccione dos luces, cuatro pisos y dos 

marcos. 

 Estructura Regular. Por el momento se usara, una estructura regular. En la 

sección 3,se discutirán las opciones para el modelado de estructuras 

irregulares. 

 Longitud de luces, altura de pisos y distancia entre marcos. ZeusNL usa 

mm para las unidades de longitud; escoja 5000mm, 3000mm y 6000mm 

respectivamente. 

 Tipo de Estructura (RC o estructuras de acero). Seleccione RC 

 Elementos por miembro. Esta opción determina en cuantos elementos se 

subdivide cada uno de los miembros de la estructura (columnas y vigas). 

Seleccione dos elementos por miembro 

 Convención para la nomenclatura de los nodos. Esta opción determina la 

forma en la que los nodos serán nombrados. La primera opción valor por 

defecto (default) registra nombres fáciles de leer. Seleccione valor por defecto. 

 Tipo de Análisis. El usuario puede seleccionar uno de los seis diferentes tipos 

de análisis que tiene ZeusNL. Escoja dynamic time-history análisis. 

 

En ZeusNL, las unidades de longitud son siempre en milímetros y las unidades de 

fuerza son los Newton; de click en el botón OK para proceder al siguiente paso  

 

Carga Aplicada 

 

En esta pantalla, se especifica el acelero grama que se va a usar en el análisis 

dinámico. El programa asume que los valores de la aceleración y de tiempo se 

dan en un archivo de texto .txt, en formato de tabla, como: 
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Fig. 2 Pantalla de Plantilla 2 (selección de acelero-grama) 
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El usuario puede especificar las columnas de tiempo y valores de aceleración la 

primera y última línea que se leerán y el factor de escala. El archivo puede ser 

seleccionado con el botón Select File, mientras que si el usuario quiere ver los 

contenidos específicos de un archivo, el botón View Text File abre un lector de 

archivos de texto. El botón Update View simplemente actualiza la entrada (es 

decir, la última línea) se ha cambiado. 

 

Aquí hay un par de cosas importantes para tener en cuenta: 

 

 Los valores del tiempo deben estar en orden ascendente y mayores a cero. 

Los valores menores o iguales a cero son simplemente ignorados por el lector. 

Por otra parte entradas no numéricas no son aceptadas. 

 Si la aceleración dada esta en unidades [g] (gravedad), entonces el factor de 

escala de 9810 es necesario para cambiar las unidades a mm/sec2. 

 El acelero grama, por defecto, será aplicado en la dirección X 

 Haciendo click derecho sobre la gráfica o la tabla, un menu desplegable muy 

útil aparecerá. El usuario puede copiar o imprimir los valores de aceleración o 

tiempo seleccionados en otras aplicaciones, procesadores de texto(por ejemplo 

Microsoft® Word) o hojas de cálculo (por ejemplo, Microsoft® Excel). Por otra 

parte, el usuario puede cambiar numerosas opciones en la gráfica (color y 

espesor de la línea, el fondo, los valores de los ejes, etc.) antes de copiarla o 

imprimirla. En ZeusNL, caso todas las tablas o grafico tienen una ventana de 

menu emergente. 

 

Después de ingresar el acelero grama seleccionado, de click en el botón Ok. Un 

modelo estructural en 3D de una construcción de cuatro pisos, que está 

compuesto por más de 1000 elementos, ha sido creado. Las cargas estáticas 

(cargas de gravedad) y las cargas dinámicas (el sismo) también han sido 

aplicadas. 
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Módulos del Programa 

Aparte de los menús y de las barras de herramientas que se encuentran 

normalmente en cualquier aplicación para el sistema operativo Windows®, en 

ZeusNL hay una serie de páginas (módulos) En cada página, se especifican 

diferentes datos de entrada. Después de la terminación del modelo, el programa 

se centra en la página de nodos y aparece la estructura. La pantalla se verá como 

Fig. 3. 

 

Fig. 3 Modelo con la Lista de Nodos Creados 

 

 

Dependiendo del tipo de análisis que se esté corriendo, aparecerán diferentes 

módulos. Por ejemplo, en análisis dinámico, hay una página marcada como Time 

Historia Curves para la descripción de la carga (aceleración), la curva aplicada a 

los soportes. Aparentemente, este módulo no es necesario en un análisis de 

empujes (convencional o adaptativo) o un análisis de valores propios (eigenvalues 
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análisis). En el mismo sentido, en el análisis de empujes hay una ventana de la 

llamada Loading Phases que no es necesario para el análisis dinámico. Para una 

completa descripción de los módulos disponibles en ZeusNL, consulte la Sección 

3. Salve el proyecto con File>Save A Tenga en cuenta que los archivos de datos 

de ZeusNL debe tener siempre tener la extensión .dat 

 

Análisis 

 

Seleccione el tipo de análisis: Dinamic Time-History, Static Time -History, 

conventional pushover, adaptative pushover, eigenvalues o static con non-variable 

loading. 

 

Materiales 

 

En el módulo Materials, el usuario puede especificar los materiales de los que 

dispondrá en el proyecto en curso. Estos materiales son luego usados en la 

definición de secciones en el módulo Sections. Cada material cuenta con un 

modelo tipo (stl0, stl1, stl2, para aceros, con1, con2, con3, con4, o frp1, para 

concreto-consulte el apéndice A para una descripción detallada del tipo de 

material), y propiedades especificas del material por ejemplo, resistencia al 

esfuerzo, módulo de Young, endurecimiento por deformación, etc. Cada material 

tiene también se especifica con un nombre el cual es especificado en el módulo 

Secctions. No hay que confundir los materiales definidos en este módulo con los 

materiales disponibles en las librerías de ZeusNL. En este caso, hay dos 

materiales de concreto, conf y unconfined para concretos confinados y no 

confinados respectivamente, con propiedades diferentes pero el mismo tipo de 

material que con2. Para una descripción comprensiva de las propiedades de un 

material, seleccione un material y de click en el botón Edit o simplemente doble 

click en el material. Una ventana similar a la que aparecerá en la Fig. 4, en la que 

el usuario puede cambiar las propiedades del material o incluso el tipo o el nombre 
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del material seleccionado. Aparte de editar los materiales existentes, es fácil 

agregar nuevos materiales dando click en el botón Add y seleccionando un 

nombre, el tipo y las correspondientes propiedades. Por otra parte, el usuario 

puede remover el material(es) seleccionado(s) con el botón Remove. 

 

Fig. 4 Cuadro de Dialogo de Propiedades del Material 

 

 

Si, por error, el usuario elimina un material, bien es muy fácil realizar un hacer -

deshacer Undo-Redo en ZeusNL. Simplemente seleccione Edit > Undo en el 

menu de comandos(o el correspondiente botón en la barra de herramientas) y el 

material será restaurado. Edit>Redo restaura la última acción des-hecha. 

 

Note, que hay algunas limitaciones en los nombres que ZeusNL usa para los 

materiales (y secciones, clases de elementos, nodos y elementos).  
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En ZeusNL, materiales, clases de elementos, nodos y nombres de elementos 

deben ser de más de 8 caracteres de tamaño. Por otra parte, no deben contener 

espacios o los caracteres # o &  

 

También, note los materiales cortados pueden ser copiados y pegados (Edit>Copy 

and Edit>Paste o usando las ventanas emergentes del click derecho en la tabla). 

Cuando un material (refiriéndonos a las entradas para definir un material en 

ZeusNL) es pegada en la tabla de materiales, si el nombre es el mismo que un 

material existente en ZeusNL, una estrella '*' es agregada al final del nombre del 

material pegado. Las propiedades del material pueden ser copiadas y pegadas y 

desde otros programas, por ejemplo Microsoft® Excel, siempre y cuando las 

entradas sean consistentes con el formato de ZeusNL. 

 

Secciones 

 

En este módulo, las diferentes secciones del modelo son especificadas. Hay 

disponibles 14 secciones tipos, incluyendo secciones de acero, de RC y 

compuestas. Cada sección es descrita con un set de dimensiones de la sección y 

si es una sección RC con el área y la localización de las barras de los aceros de 

refuerzo. Como en módulo de Materials, cada sección tiene un nombre único y 

puede ser copiado, pegado y editado. En el ejemplo, ZeusNL ha credo dos 

secciones RC: una rectangular llamada 'scol' par a las columnas (tipo rcrs) y una 

T-shaped llamada 'sbeam' para las vigas (tipo rcts). Para este ejemplo el programa 

asume que todos los elementos columnas/vigas tienen secciones idénticas. Si el 

usuario edita una de las secciones, por ejemplo 'sbeam' (de nuevo con el botón 

Edit o con doble click), un cuadro de dialogo de Section Properties aparecerá, que 

es similar a la Fig 5. En esta cuadro de dialogo, el nombre de la sección, el tipo, el 

material, las dimensiones y el refuerzo pueden ser modificadas. 
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Dependiendo del tipo de sección seleccionada diferentes número de materiales 

(una para secciones de acero, de tres a cuatro para RC y secciones compuestas) 

y dimensiones (de una a nueve) son especificadas. Los materiales disponibles son 

aquellos definidas el módulo de Materials (reinf, conf, y unc). El programa ha 

seleccionado reinf para el refuerzo, conf para la región confinada y unc para la 

región no confinada. Hay una descripción de las dimensiones necesarias, pero 

también note que cuando el usuario se centra en un cuadro de texto, una línea 

roja es dibujada en la sección ejemplo que muestra específicamente la dimensión 

que va a ser editada. 

 

Para secciones RC, el área y la localización de las barras de acero del refuerzo 

deben ser definidas. Agregar, remover y editar el refuerzo el fácil con los 

correspondientes botones y se realiza de la misma manera que en que los 

materiales fueron agregados, editados y removidos. Note, todas las barras de 

refuerzo deben estar en la región confinada del concreto. Sin embargo, dado que 

la sección es simétrica solo el acero del cuadrante positivo en los ejes 1-3 deben 

ser especificados para la sección rectangular y solo el acero en el eje positivo del 

eje 1 de la sección T. El programa genera el resto del acero. Finalmente si el 

usuario da click en el botón OK, el refuerzo se dispone en la tabla de 

Reinforcement Section las entradas están dispuestas en tres datos (As,d3,d1). 

 



109 

Fig. 5 Cuadro de Dialoga de Propiedades de la Seccion 

 

 

Clases de Elementos 

 

La librería de elementos de ZeusNL contiene un conjunto de elementos que se 

usan para modelar los elementos estructurales (vigas y columnas), elementos no 

estructurales (masa y amortiguamiento) y condiciones de borde (apoyos y juntas): 

 

Cubic. Elementos de vigas-columnas 3D elastoplasticos de formulación cubica. 

Se usa para detallar modelos inelásticos, haciendo uso de modelos de materiales 

inelásticos uniaxiales descritos anteriormente. Es responsable de la distribución de 

la inelasticidad a lo largo del miembro y en los profundo de la sección transversal. 

Joint. Elementos 3D de junta desacoplada de acciones cortantes, axiales y de 

momentos. 

Lmass. Masas agrupadas (concentradas) usadas en análisis dinámicos y de 

valores propios. 

Dmass. Elementos de masa de distribución cubica. 
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Ddamp. Elemento amortiguador (concentrado) de amortiguamiento viscoso 

utilizado en los análisis dinámicos. 

Rdamp. Elemento de amortiguación que usa el modelo de amortiguamiento de 

Rayleigh usado para el análisis dinámico. 

 

Estos tipos de elementos se usan para definir las clases de elementos. Un 

elemento de clase es un grupo de propiedades que se refieren a un elemento de 

una categoría en particular. Los tipos de elementos (diferentes tipos de elementos 

disponibles en las librerías de ZeusNL) no deben ser confundidos en la con los 

elementos de clase. En cada proyecto de ZeusNL, probablemente hay diferentes 

elementos de clase en el mismo tipo de elemento. Por ejemplo, en nuestro 

modelo, hay dos elementos de clase (columnas y vigas) del tipo de elemento 

cubico y tres elementos de clase para el elemento de tipo lmas (mass1, mass2, 

mass4). Los elementos de clase definidos aquí son usados el módulo Element 

Connectivity para definir la configuración de la malla de conectividad de los 

elementos. 

 

Nodos 

 

Después de definir los elementos de clase, el usuario necesita configurar la malla 

de nodos del elemento. En el módulo Nodes, además de una lista de nodos, se 

encuentra un gráfico en 3D de la estructura que permite una mayor visualización y 

comprensión del modelo. 

 

La mayoría de los nodos son estructurales, aunque hay también nodos no 

estructurales. La pregunta que surge es: ¿Cuál es la diferencia entre un nodo 

estructural y un nodo no estructural? Para algunos tipos de elementos (cubics, 

joint, dmass y rdamp) nodos adicionales a los de los extremos, deben ser 

especificados. Los nodos adicionales definen la orientación de los ejes locales de 

los elementos. En particular, cubic, dmass, y dramp requieren un tercer nodo para 
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definir el eje local (1) y joint requiere un tercer y cuarto nodo para definir los ejes 

locales (1) - (2). Por defecto, el efecto nodo no estructural no es visible en el área 

de dibujo. Para hacerlo visible, simplemente active la opción dibujar nodos no 

estructurales en el módulo Nodes. Otra alternativa es seleccionar Settings > 3D 

Plot Settings. Esto abre un cuadro de dialogo, en el que el usuario puede cambiar 

las configuraciones de la pantalla del grafico del modelo en 3D. Diríjase a la 

pestaña de nodos no estructurales y de click en la opción Visible, como en la Fig. 

6. El nodo no estructural aparecerá en rojo en todo alrededor del modelo. 

 

Fig. 6 Cuadro de Dialogo de Opciones de Grafico en 3D. Nodos no 

Estructurales 

 

 

Trate de navegar por las pestañas. Hay numerosas características de la 

apariencia del modelo. El usuario puede cambiar el color, el estilo y el ancho de 

las líneas, el tamaño de los nodos y los cubos de masa, insertar títulos y pies de 

página, cambiar la escala y mostrar o esconder los ejes y los muros alrededor del 

modelo.( Los detalles de esos ajustes están mas halla del alcance de este tutorial.) 

Las únicas opciones que mereces una atención especial se encuentran en la 
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pestaña General. Las propiedades 3D cambian la rotación, localización, la captura 

y la perspectiva del gráfico. Considerando que el usuario puede desear 

desbloquear el cuadro de dialogo Automatic 3D Plot Update en los casos de 

grandes estructuras (ciento o miles de nodos y elementos) y le tomara algunos 

segundos al programa actualizar el grafico. El grafico cambiara automáticamente 

cada vez que algo cambie. Si la opción es bloqueada, el usuario puede actualizar 

manualmente el grafico desde el menu emergente del gráfico. Después de tener 

una vista a las opciones cierre el cuadro de dialogo. A ´partir de ahora los nodos 

no estructurales no se van a necesitar, el usuario puede desear ocultarlos 

nuevamente con el fin de ampliar la vista de la estructura. El módulo Nodes 

contiene los botones estándar Add, Remove y Edit, pero además hay un botón 

Incrementation. Esto activa la instalación de Nodos de Incremento una opción de 

ZeusNL. El usuario puede seleccionar uno o más nodos y generar nuevos de 

manera repetida.  

 

Fig. 7 Incrementacion Automatica de Nodos 
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Por ejemplo, seleccione los nodos n111 y n112 (para seleccionar múltiples 

elementos en las tablas de ZeusNL, de click sobre el elemento que desea 

seleccionar, manteniendo presionada la tecla Ctrl). Luego, con los dos nodos 

seleccionados, de click en el botón Incrementation. Seleccione un incremento en 

los nodos de 10000. Esto quiere decir que los nodos generados tendrán nombres 

como n10111, n20111 (desde n111) y n10112, nn20112 (desde n112). También, 

un incremento en x de 1000 e incrementos en y- y z- de o. Escoja cuatro 

repeticiones (esto quiere decir que por cada nodo 4 nuevos nodos serán creados 

en decir 8 nodos en total). De click en OK y vea los nuevos nodos en el grafico en 

3D. Debería ver algo como la Fig. 8. 

 

Fig. 8 Nodos Generados con la Incrementación Automática 

 

 

La incrementación automática en los módulos Nodes, Element Conectivity y 

Applied Loading, es una poderosa herramienta que permite al usuario generar una 
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estructura fácil y eficientemente en minutos. Sin embargo, hay una restricción con 

la identificación de los nodos o elementos que va a ser incrementados: deben 

estar en formato (texto) + (numero), por ejemplo, n111 y nod201; o el texto puede 

ser omitido y solo usar números para la identificación, por ejemplo, 22 y 44. Si el 

usuario trata de incrementar el nodo n111-y1, un error de mensaje le indicara que 

el nodo no puede ser incrementado, debido a que no tiene el formato correcto.  

 

La identificación de nodos y elementos debe ser en el formato correcto (texto) + 

(números) [ o simplemente números] para ser incrementada 

 

Por el momento, como los nodos extras no son necesarios, se remueven 

Edit>Undo para eliminar la última acción y así volver al estado anterior, de lo 

contrario el programa no se ejecutara con nodos no conectados a la estructura. 

 

Hay algunas opciones en el grafico en 3D a la izquierda de la pantalla. Estas son 

las opciones más usadas frecuentemente. Hay también un botón Reset que 

regresa el grafico al estado predeterminado y un cuadro de chequeo Animate que 

permite al usuario ver el modelo desde diferentes perspectivas. El usuario también 

puede rotar el elemento si el diagrama es seleccionado con el ratón. 

 

Una característica importante es la habilidad para identificar los nodos por su 

número o por sus coordenadas x-, y- o z- . El usuario tiene que debe de hacer 

click en el encabezado del nodo o en las columnas de las coordenadas (x, y o z) 

para ordenarlos en forma descendente. 

 

Elementos de Conectividad 

 

Los diferentes elementos de la estructura se definen aquí. Cada elemento 

pertenece específicamente a una clase de elemento, y dependiendo de este 

elemento de clase pueden tener un (lmass, ddamp), tres (cubic, dmas, rdamp), o 
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cuatro nodos (junta). El modelo solo tiene elementos cúbicos estructurales y 

elementos de masa Imas. Como se mencionó en la sección previa, los elementos 

cúbicos están definidos, además de los dos nodos en los extremos, con un tercer 

nodo en que puede ser estructural o no estructural. 

 

Por ejemplo, los nodos de los extremos del primer elemento de columna 'col1111', 

son 'n111' y 'n111-y1'. Estos definen la geometría precisa del elemento, pero que 

define su sección y su orientación? La sección es 'scol' como se definió en el 

módulo Sections. Es claro que los (2) ejes locales de la sección coinciden con el 

eje (y) global. Pero que hay acerca de los otros dos ejes? Cuál de los ejes 

globales (x- o z-) coincide con el eje local (1) de la sección? Este el porqué se 

requiere de un tercer nodo para precisar la definición del elemento. Los nodos de 

los extremos junto con el tercer nodo nsn1001 definen un tercer plano en el 

espacio. El eje central de la sección [es decir, el eje 3] se equivoca en ese plano y 

coincide con el eje global (x). 

 

Como en los otros módulos, el usuario puede agregar, eliminar y editar los 

elementos seleccionados. Sin embargo, también hay la facilidad Incrementation y 

Subdivisión. El incremento automático de los elementos trabaja más o menos igual 

al incremento de nodos. Sin embargo, en este caso el incremento del número de 

elementos junto con el incremento del número de nodos, debe ser especificado. 

La subdivisión solo puede ser aplicada a elementos lineales y permite la división 

fácil y rápida de cada elemento en dos con la creación de un nuevo nodo en 

centro del elemento. El usuario puede querer subdividir un elemento en las áreas 

críticas de la estructura, con el fin de incrementar la precisión del análisis. 

 

Una característica del que el usuario encontrara muy útil, es la habilidad para 

cambiar los elementos de clase de varios elementos en un paso haciendo una 

selección múltiple y dando clikc en el botón Edit. Por ejemplo, esto es muy útil 
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cuando el usuario quiere cambiar los elementos de las columnas de un piso desde 

un elemento de de clase para otro. 

 

Restricciones 

 

El usuario puede fácilmente especificar las restricciones de los nodos 

seleccionándolos y dando click en el botón Edit. El proceso entero es en si sencillo 

sin embargo, tenga en cuenta algo muy importante con respecto a las 

restricciones:  

 

En el análisis dinámico, El DOF contenido en los soportes, debe ser liberado, en el 

sentido del sismo. 

 

Esto es por qué la restricción DOF contenida en el modelo son y+z+rx+ry+rz, pero 

no el eje x (x es la dirección del sismo) 

 

Curvas Tiempo-Historia 

 

En este módulo se especifican los tramos se curvas lineales para el análisis 

dinámico (o time-history). Uno ha sido creado con la plantilla (template) al 

seleccionar el registro. La curva definida se aplicara con ciertas reglas a la 

estructura en el próximo modulo, Aplied Loading. 

 

Hay un cuadro a la izquierda de la ventana principal para el tiempo de inicio Star 

Time del análisis. Este el tiempo para el inicio del análisis (cero para el modelo). 

 

Si el usuario da doble click sobre la curva, El cuadro de dialogo Edit Curve se 

abrirá. Aquí la curva aplicada puede ser cambiada, por ejemplo la duración e 

incluso el archivo seleccionado. Para cada curva hay un parámetro de retraso. El 

retraso (que siempre debe ser positivo) es el tiempo a partir del tiempo de la hora 
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de inicio que la curva se aplica a la estructura. De esta manera es muy fácil 

simular una excitación asincrónica especificando la misma curva con diferentes 

retrasos. 

 

Carga Aplicada 

 

En este módulo se especifican las cargas aplicadas. Hay cuatro diferentes tipos de 

carga 

 

Initial. Estas son cargas estáticas que se aplican antes de cualquier carga 

variable. Pueden ser fuerzas o desplazamientos que se prevén aplicar a los nodos 

 

Proportional. Estas son cargas estáticas que tienen una variación proporcional. 

La magnitud de la carga está dada en cada paso por el valor nominal (que es 

constante) y por un factor de carga (la cual es variable). Las cargas tipo 

Proportional pueden ser fuerzas o desplazamientos aplicados en los nodos.  

 

Time-History Estas son cargas estáticas que varían según las diferentes curvas 

de cargas en el dominio del pseudo-tiempo. La magnitud de la carga en cada paso 

está dado por el producto de su valor nominal (que es constante) y el 

correspondiente valor de carga que varía según la curva de carga. Las cargas 

time-history pueden ser fuerzas o desplazamientos en los nodos. 

 

Dinamic. Estas son aceleraciones o fuerzas que varían de acuerdo a diferentes 

curvas de carga en el dominio del tiempo real. El producto de su valor nominal 

constante y el factor de carga variable es obtenido de la curva de carga que para 

un tiempo da la magnitud de la carga. Las cargas dinamic pueden ser fuerzas o 

aceleraciones aplicadas en los nodos en las coordenadas globales. 
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Para el análisis dinámico del ejemplo se usaran, las cargas iniciales (aplicadas por 

la masa de la estructura) y las cargas dinámicas (aplicadas en los apoyos en la 

dirección -x). Nuevamente el usuario puede agregar, remover, editar o incrementar 

las cargas.  

 

Observe que en este módulo el usuario puede agregar la misma carga (valor, 

dirección, tipo) a varios nodos en un simple paso, especificando varios nodos en el 

cuadro de dialogo Add Load (usando la tecla ctrl para realizar la selección 

múltiple)  

 

Estados de Equilibrio 

 

En este módulo se especifican las etapas de intervalos de tiempo en los que el 

equilibrio estructural se establece. En otras palabras, el usuario especifica los 

puntos en el tiempo en los cuales las fuerzas y los desplazamientos de la 

estructura se equilibran. 

 

El usuario puede tener diferentes etapas con diferentes pasos de tiempo, 

dependiente de la dificultad en la convergencia que puedan surgir en diferentes 

tiempos del análisis dinámico (para un análisis más exhaustivo se requiere más 

puntos de tiempo es decir un menor paso del tiempo). Esto se hace especificando 

el tiempo final de la etapa (que deberá ser mayor que el tiempo de final de la etapa 

anterior) y el número de puntos. En el módulo de curvas Time-history dividido por 

el número de pasos. 

 

El usuario puede tener diferentes etapas con diferentes pasos de tiempo, 

dependiente de la dificultad en la convergencia que puedan surgir en diferentes 

tiempos del análisis dinámico (para un análisis más exhaustivo se requiere más 

puntos de tiempo es decir un menor paso del tiempo). Esto se hace especificando 

el tiempo final de la etapa (que deberá ser mayor que el tiempo de final de la etapa 
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anterior) y el número de puntos. En el módulo de curvas Time-history dividido por 

el número de pasos. 

 

Ejecución del Análisis 

 

Después de revisarlos diferentes módulos, es el momento de ejecutar los análisis. 

Guarde el proyecto (File > Save) y seleccione Run > Run o el correspondiente 

botón de la tabla de herramientas. Después de realizar algunas comprobaciones 

de integridad, el programa inicia a funcionar. Dependiendo del tamaño de la 

estructura, las cargas aplicadas y el procesador de la PC, el análisis puede tardar 

desde unos segundos hasta varias horas. Esto es significativamente mayor que el 

tiempo requerido en otros paquetes de elementos finitos y esto es atribuido a la 

manera en que se modela la propagación de la inelasticidad a través de la longitud 

del miembro y en lo profundo de la sección recta. Sin embargo, los resultados se 

ven incrementados en estabilidad y una significativa mejora en la precisión. 
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Fig. 9 Ejecución del Análisis 

 

 

Obtención de los Resultados 

 

ZeusNL tiene dos herramientas para realizar el post-proceso que se 

complementan. El Post-Processor, el cual crea curvas con los efectos de la acción 

del análisis (Desplazamientos, fuerzas, tensiones, etc.) y el visor de la forma 

deformada, con el cual se puede ver la forma deformada de la estructura en los 

diferentes pasos del tiempo del análisis. Tanto para abrir el tipo de archivo de base 

de los resultados de ZeusNL (de extensión .num), leerlos y mostrar los datos. El 

usuario puede ejecutarlos con los comandos correspondientes del menu de 

herramientas. 

 

Post-Processor 

 

El post-processor es una habilidad que facilita la derivación de diagramas con los 

resultados de los análisis. 
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Por ejemplo, si el usuario está tratando de trazar la deriva de entrepiso entre el 

nodo superior izquierdo y en la parte inferior izquierda de los nodos del primer 

pórtico (N151 y N111 respectivamente) contra el tiempo, Ejecute el post-processor 

con Tool > Post-processor y abriendo el archivo del proyecto .num. 

 

Seleccione de una de las listas desplegables en la esquina superior izquierda de la 

ventana: Time para el eje -x y Interstory Drift para el eje -y. En el cuadro de 

dialogo que se abre, escoja los nodos n151 y n111, seleccione la direccion 

apropiada (Ux es la dirección del sismo y de click en el botón OK). 

 

En muchos casos, el usuario tendra que encontrar un elemento (por ejemplo, un 

nodo) en un lista desplegable cpn cientos de elementos. Si el nombre de elemento 

(el nodo) es conocido, comience a digitarlo cuando la lista desplegable se resalte y 

ZeusNL lo encontrara. 

 

Fig. 10 Post- Processor de ZeusNL 
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De click en el botón View Curve y el grafico será creado. Los valores del grafico se 

mostraran en la tabla en la esquina inferior izquierda. 

 

Para convertir los valores de desplazamiento de mm a cm, multiplique todos los 

valores del eje -y del dibujo por 0.1 seleccione Tools > Settings y cambie el factor 

multiplicador del eje -y por 0.1. El diagrama será nuevamente dibujado con todos 

los valores del eje -y multiplicados por 1/10. Note, que el usuario puede escoger 

cualquier valor (positivo, negativo, o incluso cero) para los factores multiplicadores 

de los ejes -y y -x. 

 

Con el Post-Processor, el usuario puede fácilmente crear varios diagramas, 

desplazamiento nodal y rotaciones, derivas de entrepisos, reacciones en los 

apoyos, fuerzas de corte, etc. 

 

El diagrama y las tablas de valores pueden ser copiadas a otras aplicaciones 

como, Microsoft® Word y Microsoft® Excel. Hay muchas opciones (Tool > Graph 

Options) para el diagrama y el usuario puede cambiar casi todos los aspectos de 

este el fondo, el color, el estilo y el grosor de la línea, las etiquetas de los ejes, etc. 

Note, que el usuario puede realizar acercamientos con el menu de comandos o 

con el correspondiente botón de la barra de herramientas. Para realizar un 

acercamiento en un área especifica selecciónela moviendo el puntero del ratón 

desde la esquina superior izquierda hasta la esquina inferior derecha. Para des-

hacer la selección, mueva el ratón en la dirección contraria (desde la derecha 

hacia la izquierda), el diagrama vuelve al inicio.  

 

Para eliminar la pendiente de la gráfica, vaya a la pestaña Panel de la ventana 

Options y desactive la casilla de verificación Gradient-Visible. El resultado es un 

gráfico plano con un fondo blanco listo para copiar a un procesador de texto. 
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Visor de la Forma Deformada del Modelo 

 

Con el Post-Processor, el usuario puede crear rápida y fácilmente diagramas 

seleccionados de un análisis y copiar o imprimir. Sin embargo, surgen preguntas. 

Por ejemplo: ¿Que sucede cuando el usuario quiere ver como se ve la estructura 

realmente a los 6.02seg, cuando ocurre el máximo desplazamiento en el nodo 

n151? ¿Hay una manera de identificar los entrepisos? ¿Cómo se ve a segunda 

forma modal de la estructura? 

 

El visor de la forma deformada de la estructura responde a estas preguntas. Cierre 

el Post-Processor (esto lleva al usuario a la ventana principal del programa (Main 

Program) y abra Tools > Deformed Shape Viewer. 

 

Desde el visor de formas, abra el archivo num este archivo se ha creado junto con 

el análisis. Después de que el archivo se ha cargado, una lista con los pasos del 

tiempo utilizados en el análisis aparecen en pantalla. Seleccione el paso de tiempo 

6.68sec y de click en el botón View Shape. En un par de segundos la forma 

deformada aparece y está lista para ser copiada o pegada. 
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Fig. 11 Visor de la Forma Deformada (análisis dinámico) 

 

 

 

  



125 

 

TUTORIAL 2 – ANÁLISIS DE VALORES PROPIOS (EIGENVALUE) 

 

El análisis dinámico se ha ejecutado con una estructura de 4 pisos, pero si el fin es 

obtener las características dinámicas de dicha estructura, por ejemplo, los 

periodos y las formas modales, un análisis de valores propios (eigenvalues) debe 

ser realizado. 

 

Hay dos formas para hacer esto. La más vigorosa seria modificar el modelo 

existente a las necesidades del análisis de valor propio. Sin embargo podrían 

aparecer problemas al cambiar de un análisis a otro. La segunda forma es 

creando una nueva estructura idéntica a la del modelo desde las plantillas. 

Seleccione File > Create from Template y especifique las mismas características 

estructurales del ejemplo anterior, pero ahora escoja análisis de eigenvalues 

envés de análisis dinámico. 

 

Hay un par de cambios en este modelo, en comparación con el primer modelo de 

análisis: 

 

Hay unos módulos que no están: Time-History Curves, Loads, y Equilibrium 

Stages. Todos estos módulos están relacionados con la carga aplicada y por 

consiguiente, no son necesarios para el análisis de valores propios. 

 

El x-DOF de los soportes que se relaciona con el análisis dinámico esta ahora 

restringido. 

 

Además de estas diferencias, los módulos deberían ser idénticos. Guarde el 

proyecto y ejecúteloLuego de que el análisis sea completado (por que el análisis 

de valores propios, no debería de demorar más de unos segundos), abra el visor 

de la forma deformada y abra del archivo de análisis .num. Una lista de las formas 
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modales convergentes aparecerá. Seleccione cada uno de ellos y de click View 

Shape para ver las formas modales (fig. 12). Nuevamente, el usuario puede 

copiar, imprimir o cambiar la apariencia del grafico en 3D. 

 

Fig. 12 Visor de la Forma Deformada (analisis de valores propios) 

 

 



127 

Fig. 13 Pantalla de Plantillas (análisis pushover) 

 

 

Fig. 14 Pantalla de Plantillas 2 (analisis pushover) 
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TUTORIAL 3 – ANÁLISIS PASO A PASO (PUSHOVER) 

 

La usara la plantilla de ZeusNL para crear un modelo de la estructura para un 

análisis de paso a paso. Seleccione Static Pushover Análisis como el tipo de 

análisis, aparecerá una lista desplegable aparecerá preguntando al usuario por la 

distribución de las cargas (uniforme o triangular). Seleccione la que se encuentra 

seleccionada por defecto Uniform (fig. 13). De click en OK y un nuevo cuadro de 

dialogo se abrirá en el que se especifica el valor objetivo de la carga proporcional 

aplicada en cada entrepiso (Fig. 14). 

 

Las principales diferencias entre los modelos para el análisis dinámico y el análisis 

paso a paso son: 

 

No hay masas.  Las masas no son necesarias ya que no hay fuerzas de inercia en 

el análisis estático paso a paso. 

 

La X-DOF es restringida en los soportes. 

 

Los módulos Time-History Curves y Equilibrium Stages no se encuentran. En 

cambio hay un nuevo módulo extra llamado Loading Phases. Este módulo define 

las fases controladas que se usaran para trazar las curvas de deflexión de carga 

para carga proporcional. Tres tipos de control están disponibles: 

 Control de la Carga (Load Control) Se refiere a la situación donde el factor de 

carga λ es directamente incrementado y los desplazamientos globales de la 

estructura son determinados en cada nivel del factor de carga. Las cargas 

aplicadas pueden ser fuerzas o desplazamientos. 

 Control de la Respuesta (Response Control) Se refiere a la situación donde la 

respuesta (desplazamiento/rotación) de un nodo, especificado por el usuario, 

aumenta en cada incremento. La carga aplicada y las deformaciones en los 

otros nodos, se determina por la solución del programa. 
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Control de Respuesta Automática (Automatic Response Control) Se refiere al 

procedimiento en el cual un nuevo DOF se escoge automáticamente para el 

control de la respuesta, cada vez que surgen problemas con la convergencia 

durante el análisis. El nodo elegido es el que tienen la mayor taza de la respuesta 

tangencial. 

 

Existen diferentes esquemas que pueden ser aplicados. Por el momento, el 

creado por defecto por la plantilla será usado: una fase de control de carga y una 

fase de control de respuesta automático. Por el momento, solo vale la pena 

mencionar el objetivo del desplazamiento del control automático (cuál es la 

momento en el que el análisis se detendrá, si no se ha detenido antes por 

problemas de divergencia) y la dirección de la libertad controlada (en este caso 

dejamos la dirección –x).  

 

Después de la terminación del análisis,  al igual que en los anteriores tutoriales, 

los resultados pueden ser procesados con el Post-Procesador y con el visor de la 

forma deformada. (Fig. 16 y 17) 
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Fig. 15 Modelo CreadoPara el Analisis Paso a Paso 

 

 

Fig. 16 Curva de Desplazamiento Maximo vs Factor de Carga 
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Fig. 17 Forma Deformada al final del Procedimiento 
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TUTORIAL 4 –ANÁLISIS ESTÁTICO DE TIEMPO-HISTORIA (STATIC TIME-

HISTORY ANÁLISIS) 

 

Este análisis es usualmente usado para la simulación de ensayos. Por ejemplo, el 

usuario puede imaginar modelar un ensayo cíclico en un muro RC. Suponer que la 

carga se compone de una fuerza vertical y un desplazamiento variable aplicado en 

la parte superior del muro (Fig. 18),  de acuerdo a un patrón predefinido 

 

Fig. 18 Ensayo Cíclico en un Muro RC 

 

 

Esta ves no se uso una plantilla. El modelo se genero a partir de cero, modulo por 

modulo. Incluso sin la facilidad de la función Template, crear un modelo un modelo 

con ZeusNL es simple. 

 

Configuración Estructural 

 

En el módulo Analysis, seleccione el análisis Static Time-History. En el módulo 

Materials, el usuario definirá cuatro materiales para el proyecto, uno para las 

barras reforzadas y tres para el concreto, ya que la sección de la pared RC es 

rcfws consiste de cuatro diferentes materiales. 
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Use el tipo de  material stl1  para el acero a lo largo del muro y material tipo 2 para 

los tres materiales de concreto (no confinados: con1; confinamiento parcial: con2; 

totalmente confinados: con3). Tenga en cuenta, que los parámetros de con1, con2 

y con3 son exactamente los iguales (a la compresión y resistencia a la tracción, 

trituración por la tensión), además del factor de confinamiento. 

 

Fig. 19 Materiales Utilizados en el Análisis Estático de Tiempo-Historia 

 

 

Fig. 20 Sección de Muro Usado Para el Análisis 

 

 

Con estos cuatro materiales, el usuario puede ahora definir la sección del muro 

(Fig. 20) usando el tipo de sección rcfws y también definir un elemento de clase 

cubico al que llamara Wall, con la nueva sección y (por ejemplo) por lo menos 250 

puntos de control. Los nodos, elementos y restricciones del modelo se muestran 

en las Fig. 22, 23 y 24. Para su obtención, es recomendable usar la función 
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Incrementación del programa. Por ejemplo, después de definir el primer elemento 

1, el usuario puede fácilmente obtener los otros elementos como en la Fig. 23. 

Además, note que el nodo no estructural 100 que es usado para la definición de 

los elementos y que todos los nodos están restringidos para deformaciones fuera 

de los planos (z + rx + ry). 

 

Fig. 21 Modelamiento de los Nodos 

 

 

Fig. 22 Modelamiento de los Elementos 
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Fig. 23 Uso del Incremento Automatico de Elementos para Obtener los 

Elementos 2-10 a Partir del Elemento 1 

 

 

Fig. 24 Restricciones del Modelo 

 

 

El siguiente paso es determinar la carga aplicada, la cual consiste de una fuerza 

constante vertical y un desplazamiento variable horizontal en el nodo 11. Primero 

describa el patrón de para la carga horizontal. Esto lo hace en el módulo Time-

History Curve. Selecciones Create a Curve, lo que lleva al usuario al cuadro de 

dialogo New User-Defined Curve. Defina el dominio del tiempo y las coordenadas 

y el factor de carga de la carga en la tabla, así como el nombre de la curva (Fig. 

25) y de click en OK. 
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Fig. 25 Nueva Curva de Carga Definida por el Usuario 

 

 

Las cargas aplicadas se puede definir en el módulo Applied Loading como una 

carga inicial y una carga estática de tiempo-historia (Fig. 26). El proceso es 

extremadamente sencillo. Note que, la carga vertical se dirige hacia abajo por lo 

tanto debe ser negativa y que para aplicar dos o tres veces la carga variable 

horizontal, el usuario solo tendría que cambiar el valor del parámetro del factor de 

carga de 1.0 a 2.0 o 3.0, respectivamente. 

 

Fig. 26 Cargas Aplicadas al Modelo 

 

 

Finalmente, los estados de equilibrio necesitan ser definidos. Para nuestro test en 

los 16seg del tiempo se definirán 320 pasos. El paso del tiempo será entonces de 

0.05seg. 
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El modelo está listo para correr. De click en  Run > Run  y espere a que termine el 

análisis. Después de terminar, la curva de histéresis del muro debe ser trazada. 

Ejecute el post procesador (Tool > Post-Processor) y abra el archivo del proyecto 

con extensión .num. Escoja el desplazamiento en –x para el nodo 11 para el eje –x 

del gráfico y el momento Mz en el apoyo en el nodo 1 para el eje –y del gráfico. De 

click en el botón View Curve para observar el resultado de la curva de histéresis. 

En este punto se necesita formatear. 

 

Las unidades del momento por defecto son N*mm. Vaya al cuadro de dialogo 

Tools > Settings y cambie el factor multiplicador en el eje –y por 1e-6 o 0.000001. 

Ahora seleccione Tools > Graph Options y en la pestaña Panel desactive la casilla 

Gradient-Visible. En pestaña Axis, diríjase al sub-menú Title a la izquierda y 

cambie los títulos del eje por „Support Moment (kNm) y „Top Displacement (mm), 

respectivamente. Como resultado ya tendrá una grafica  
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Fig. 27 Diagrama de la Curva de Histérisis 
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